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1 Getting Started

Product Description
Communicate with in-vehicle networks using CAN protocol

Vehicle Network Toolbox™ provides connectivity to CAN devices from
MATLAB® and Simulink®. The toolbox provides functions for encoding,
decoding, and filtering CAN messages, enabling you to transfer messages
between the MATLAB workspace and a CAN bus. You can use the toolbox

to run test sequences that log and record CAN messages for later analysis.
You can also use it to connect with industry-standard CAN database files and
replay recorded sequences of messages. The toolbox includes Simulink blocks
that enable you to simulate message traffic on a CAN bus or connect models
to a live network. Vehicle Network Toolbox supports CAN interface devices
from Vector, Kvaser and National Instruments®.

Key Features

e MATLAB functions for transmitting and receiving CAN packets
¢ CAN communication blocks for connecting a CAN bus to a Simulink model

¢ Bit packing and unpacking functions and blocks for simplified encoding and
decoding of CAN messages

e Message traffic GUI for visualizing live CAN network traffic
® Message filtering and logging

e Support for Vector and Kvaser interface hardware and Vector CAN
database (.dbc) files
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Product Capabilities

In this section...

“Vehicle Network Toolbox Characteristics” on page 1-3
“Interaction Between the Toolbox and Its Components” on page 1-4

“Expected Background ” on page 1-6

“Related Products” on page 1-6

Vehicle Network Toolbox Characteristics

The toolbox is a collection of functions built on the MATLAB technical
computing environment.

You can use the toolbox to:

¢ “Connect to CAN Devices” on page 1-3

e “Use Supported CAN Devices and Drivers” on page 1-4

¢ “Communicate Between MATLAB and CAN Bus” on page 1-4
¢ “Simulate CAN Communication” on page 1-4

® “Visualize CAN Communication” on page 1-4

Connect to CAN Devices

Vehicle Network Toolbox provides host-side CAN connectivity using defined
CAN devices. CAN is the predominant protocol in automotive electronics by
which many distributed control systems in a vehicle function.

For example, in a common design when you press a button to lock the doors
In your car, a control unit in the door reads that input and transmits lock
commands to control units in the other doors. These commands exist as data
in CAN messages, which the control units in the other doors receive and act
on by triggering their individual locks in response.
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Use Supported CAN Devices and Drivers

You can use Vehicle Network Toolbox to communicate over the CAN bus
using supported Vector, Kvaser, or National Instruments devices and drivers.

See “Supported Hardware” on page 1-10 for more information.

Communicate Between MATLAB and CAN Bus

Using a set of well-defined functions, you can transfer messages between the
MATLAB workspace and a CAN bus using a CAN device. You can run test
applications that can log and record CAN messages for you to process and
analyze. You can also replay recorded sequences of messages.

Simulate CAN Communication

With Vehicle Network Toolbox block library and other blocks from the
Simulink library, you can create sophisticated models to connect to a live
network and to simulate message traffic on a CAN bus.

Visualize CAN Communication

Using CAN Tool, a simple graphical user interface, you can monitor message
traffic on a selected device and channel. You can then analyze these messages.

Interaction Between the Toolbox and Its Components
Vehicle Network Toolbox is a conduit between MATLAB and the CAN bus.
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CAN
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CAN
Module
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In this illustration:

CAM
Module

CAMN
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Wehicle Netwaork

Taoolbox

MATLAE

e Six CAN modules are attached to a CAN bus.

®* One module, which is a CAN device, is attached to the Vehicle Network

Toolbox, built on the MATLAB technical computing environment.
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Using Vehicle Network Toolbox from MATLAB, you can configure a channel
on the CAN device to:

® Transmit messages to the CAN bus.

® Receive messages from the CAN bus.

® Trigger a callback function to run when the channel receives a message.

e Attach the database to the configured CAN channel to interpret received
CAN messages.

e Use the CAN database to construct messages to transmit.
¢ Log and record messages and analyze them in MATLAB.
e Replay live recorded sequence of messages in MATLAB.

® Build Simulink models to connect to a CAN bus and to simulate message
traffic.

® Monitor message traffic with the CAN Tool.
Vehicle Network Toolbox is a comprehensive solution for CAN connectivity in

MATLAB and Simulink. Refer to the function and block chapters for more
information.

Expected Background

This document assumes that you are familiar with these products:

¢ MATLAB — To write scripts and functions, and to use functions with the
command-line interface.

e Simulink — To create simple models to connect to a CAN bus or to simulate
those models.

e Vector CANdb — To understand CAN databases and message and signal
definitions.

Related Products

MathWorks provides several products that are relevant to the kinds of tasks
you can perform with Vehicle Network Toolbox software and that extend the
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capabilities of MATLAB. For information about these related products, see
the toolbox product page on the MathWorks Web site.
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Install Required Components

In this section...

“Required Components” on page 1-8
“Install Devices and Drivers” on page 1-8

“Install the Toolbox” on page 1-10

“Supported Hardware” on page 1-10

Required Components

To communicate on CAN networks from the MATLAB workspace and using
Simulink models, install these components:

e Current MATLAB version
e Current Vehicle Network Toolbox software

e Hardware, drivers, and driver libraries for your devices

Note To use the Vehicle Network Toolbox block library, install the current
Simulink version.

Install Devices and Drivers

® “Vector Hardware Devices and Drivers” on page 1-8
e “Kvaser Hardware Devices and Drivers” on page 1-9

e “National Instruments Devices and Drivers” on page 1-10

Vector Hardware Devices and Drivers

You need the latest version of the driver for your device to use with Windows®
XP, Windows Vista™, or Windows 7.



Install Required Components

The documentation from Vector provides installation instructions for
hardware devices such as CANcaseXL, CANboardXL, and CANcardXL,
drivers, and support libraries.

These drivers are available for download from the Vector Web site at:
https://www.vector-worldwide.com/va_downloadcenter_us.html.

Drivers for 32-bit and 64-bit Windows are available in separate packages.
Download and install the latest version and check the appropriate box during
the installation for the hardware you want to use. Virtual channels are also
installed with the hardware drivers.

XL Driver Library. Download and install the latest version of the XL Driver
Library from the Vector Web site. A single package contains the driver library
for 32-bit and 64-bit Windows. After you install the library:

¢ If you have a 32-bit system, copy the file vxlapi.dll from the installation
folder to the windows root\system32 folder.

e If you have a 64-bit system, copy the file vxlapi64.dll from the
installation folder to the windows root\system32 folder.

¢ If you have a 64-bit system and need to run the 32-bit version of Vehicle
Network Toolbox software. Copy the vxlapi.dll from the installation
folder to the windows root\syswow64 folder.

Kvaser Hardware Devices and Drivers
You need the latest version of the driver for your device to use with Windows

XP, Windows Vista, or Windows 7. Refer to your Kvaser device documentation
for hardware installation instructions.
Drivers for your Kvaser devices are available on the Kvaser Web site at:

http://www.kvaser.com/download/main.php

Drivers for 32-bit and 64-bit Windows are available in the same package.
Virtual channels are also installed with the hardware drivers.

1-9
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National Instruments Devices and Drivers

You need the latest version of the driver for your device to use with Windows
XP, Windows Vista, or Windows 7. Refer to your National Instruments device
documentation for hardware installation instructions.

Install the NI CAN programming library from the National Instruments Web
site. This will install both the drivers and the driver libraries.

Drivers for 32-bit and 64-bit Windows are available in the same package.
Virtual channels are also installed with the hardware drivers.

Note You can use National Instruments only on a 32-bit system or a 32-bit
MATLAB installed on a 64-bit system.

Install the Toolbox

Determine if Vehicle Network Toolbox software is installed on your system by
typing the following in the MATLAB Command Window:

ver

The Command Window display information about the MATLAB version you
are running, including a list of installed add-on products and their version
numbers. Check the list to see if Vehicle Network Toolbox name appears.

For information about installing the toolbox, refer to the installation
documentation for your platform. If you experience installation difficulties,
look for the installation and license information at the MathWorks Web site:

http://www.mathworks.com/support

Supported Hardware

Vehicle Network Toolbox supports Vector, Kvaser, and National Instruments
CAN devices.


http://www.ni.com/drivers/
http://www.mathworks.com/support

Install Required Components

Supported Vector Devices

* CANcaseXL

* CANcaseXLe

® CANboardXL

¢ CANboardXL pxi
¢ CANboardXL PCle
¢ CANcardXL

® CANcardX

You can also use the toolbox with virtual CAN channels available with Vector
hardware drivers.

Supported Kvaser Devices
Support for Kvaser CAN devices, including these product families:

e WLAN
PCMCIA
e Leaf

e Memorator
e PCI
e USB

You can also use the toolbox with virtual CAN channels available with Kvaser
hardware drivers.

For a full list of devices, see the Supported Hardware page.

Supported National Instruments Devices
For a complete list of supported NI CAN devices, see the Supported Hardware
page
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Vehicle Network Communication in MATLAB

Workflows in this section are sequential and will help you understand how
the communication works. You can also see code snippets and map them
to the examples in the next section
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Vehicle Network Communication in MATLAB®

New

New or same
message?

Same

Transmit Workflow

Create a CAN
Channel

l

Configure channel
properties

l

Start configured
channel

Using
database?

Build messages

|

Pack signal data

Transmit
message

More to
transmit?

Done with

channel

Disconnect the
channel and
clear workspace

Message transmit
complete

canch =

canChannel ( *Vector’, ' CANcaseXL

configBusSpeed (canch,

start (canch)

Open database| "

To use a database:

msglul = canMessage (db,
To build signals without a database:
meglul = canMessage (500,

To use a database:
maglut.Signals.signallame =
To pack signals without a database::

l pack

(msgbut, 25, 0, 16, ‘I

transmit{canch,msglut)

stop (canch)
clear all

fal

i1

25000)

‘mezzagelamna’ )

ze, 8)

5000

ittlekndian®)

canDatabase{ ‘dbName.dbc”)
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Receive Workflow

Create a CAN canch =
Channel canChannel (*“Vector’, ' CANcaseXL 1',1)
¥
Confpigouprzr;r;asnnel configBusspeed (canch, 25000)
Star;:::g:.lred start {canch)

. Open and db =
Using [;?lad'l canDatabase (‘dbnane.dbe’)
database? databa
2 = canch.Database = db
Receive
™ messages
message
k.
Examine msgin
messages

i

Examine signal
data

msgln.Signals

More to receive

Done with
channel

Disconnect the R
channel and clear all
clear workspace

Message receive
complete
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Vehicle Network Communication Examples

In this section...

“Prerequisites” on page 1-15

“Discover Installed Hardware” on page 1-16
“Create a CAN Channel” on page 1-17
“Configure Properties” on page 1-18

“Start the Channel” on page 1-19

“Create a Message” on page 1-20

“Pack a Message” on page 1-21

“Transmit a Message” on page 1-22
“Receive a Message” on page 1-23

“Unpack a Message” on page 1-25

“Save and Load a CAN Channel” on page 1-25
“Filter Messages” on page 1-26

“Multiplex Signals” on page 1-27
“Configure Silent Mode” on page 1-30

“Disconnect Channels and Clean Up” on page 1-31

Prerequisites

Examples follow a sequential workflow for configuring CAN communications.
Use these examples sequentially MATLAB Command Window.

In the example, create two CAN channels using canChannel, and canHWInfo
to obtain information about the devices installed on your system. Edit the
properties of the first channel and create a message using canMessage.
Transmit the message from the first channel using transmit, and receive it
on the other using receive .

Before you follow this example, make sure you:

1-15
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* Complete your toolbox installation before you try out the examples.

® Connect the two channels in your CAN device with a loopback connector.

The following examples use the Vector CANcaseXL hardware. You can
substitute 1t with any other supported hardware.

Discover Installed Hardware

1 Get information about the CAN hardware devices on your system:

info

canHWInfo

MATLAB displays the following information:

CAN Devices Detected

Kvaser
Kvaser
NI
NI
NI
NI
Vector
Vector
Vector

Vector

Device |

Virtual 1 |
Virtual 1 |
virtual (CAN256) |
Virtual (CAN257) |

Series 847X Sync USB (CANO)
Series 847X Sync USB (CANT1)

CANcaseXL 1 |
CANcaseXL 1 |
Virtual 1 |
Virtual 1 |

Channel |

2

| 1
| 1
1

2

1

2

Serial Number

Constructor
e e
canChannel('Kvaser', 'Virtual 1', 1)
canChannel('Kvaser', 'Virtual 1', 2)
canChannel('NI', 'CAN256')
canChannel('NI', 'CAN257')

| 14E1B6E
| 14E1B68
24365
24365
0
0

Use GET on the output of CANHWINFO for more information.

| canChannel('NI', 'CANO')
| canChannel('NI', 'CAN1')

canChannel('Vector', 'CANcaseXL 1', 1)
canChannel('Vector', 'CANcaseXL 1', 2)
canChannel('Vector', 'Virtual 1', 1)
canChannel('Vector', 'Virtual 1', 2)

2 Get details about all available CAN channels by typing:

info.VendorInfo(1).ChannelInfo(1)

3 Press Enter. MATLAB displays information such as:

can.vector.ChannellInfo handle
Package: can.vector
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Properties:
Device: 'CANcaseXL 1'
DeviceChannelIndex: 1
DeviceSerialNumber: 24365
ObjectConstructor: 'canChannel('Vector', 'CANcaseXL 1',1)"

Create a CAN Channel

Note This example assumes that you have a loopback connection between
the two channels on your CAN device.

1 Create the first CAN channel on an installed CAN device:

canch1l = canChannel('Vector', 'CANcaseXL 1',1)

Notes You cannot use the same variable to create multiple channels
sequentially. Clear any channel in use before using the same variable
to construct a new CAN Channel.

You cannot create arrays of CAN channel objects. Each object you create
must exist as its own individual variable.

Press Enter after you create the connection. MATLAB displays a summary
of the channel properties:

Summary of CAN Channel using 'Vector' 'CANcaseXL 1' Channel 1.

Channel Parameters: Bus Speed is 500000.
Bus Status is 'N/A'.
Transceiver name is 'CANpiggy 251mag (Highspeed)'.
Serial Number of this device is 24811.
Initialization access is allowed.

No database is attached.

Status: Offline - Waiting for START.
0 messages available to RECEIVE.
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0 messages transmitted since last start.

0 messages received since last start.
Filter History: Standard ID Filter: Allow All | Extended ID Filter: Allow All.

3 Create a second CAN channel object.

canch2 = canChannel('Vector', 'CANcaseXL 1',2)

You used the canChannel function to connect to the CAN device. To identify
installed devices, use the canHWInfo function.

Configure Properties

You can set the behavior of your CAN channel by configuring its property
values. For this exercise, change the bus speed of channel 1 to 250000 using
the configBusSpeed function.

Tip Configure property values before you start the channel.

1 Display the properties on canch1:

get(cancht)

MATLAB displays all properties on the configured channel:

General Settings:
BusStatus = 'N/A'
Database = []
InitializationAccess = 1
MessageReceivedFcn = []
MessageReceivedFcnCount = 1
MessagesAvailable = 0
MessagesReceived = 0
MessagesTransmitted = 0
ReceiveErrorCount = 0
Running = 0
SilentMode = 0
TransmitErrorCount = 0

1-18
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Device Settings:
Device = 'CANcaseXL 1'
DeviceChannellIndex = 1
DeviceSerialNumber = 24811
DeviceVendor = 'Vector'

Transceiver Settings:
TransceiverName = 'CANpiggy 251mag (Highspeed)'
TransceiverState = 16

Bit Timing Settings:
BusSpeed = 500000

SJw = 1
TSEG1 = 4
TSEG2 = 3

NumOfSamples = 1

2 Change the BusSpeed property of the channel to 250000:
configBusSpeed(canch1, 250000)

3 To see the changed property value, type:
get(canch1i)

MATLAB displays all properties on the configured channel as before, with
the changed BusSpeed property value:

BusSpeed = 250000

4 Change the bus speed of the second channel (canch2) by repeating steps
2 and 3.

Start the Channel

Start your CAN channels after you configure all properties.

1 Start the first channel:

1-19
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start(canch1)

2 Start the second channel:

start(canch2)

3 To check that the channel is online, type the channel name in the Command
Window. The Status section indicates that the channel is now online, as
in this example:

>> cancht

Status: Online.
0 messages available to RECEIVE.
0 messages transmitted since last start.

0 messages received since last start.

Filter History: Standard ID Filter: Allow All | Extended ID Filter: Allow All.

Create a Message

After you set all the property values as desired and your channels are online,
you are ready to transmit and receive messages on the CAN bus. For this
exercise, transmit a message using canch and receive it using canchi. To
transmit a message, create a message object and pack the message with the
required data.

1 Build a CAN message of ID 500 of standard type and a data length of
8 bytes:

messageout = canMessage (500, false, 8)

The message object 1s now:

messageout =

can.Message handle
Package: can
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Properties:
ID: 500
Extended: 0O
Name: ‘"'
Database: []
Error: O
Remote: O

Timestamp: 0O
Data: [0 0 0 0 0 0 0 O]

Signals: []
Methods, Events, Superclasses

The fields in the message show:

¢ can.Message (Normal Frame) — Specifies that the message is not an
error or a remote frame.

e ID — The ID you specified and its hexadecimal equivalent.
¢ Extended — A logical 0 (false) because you did not specify an extended ID.
¢ Data — A uint8 array of Os specified by the data length.

Refer to the canMessage function to understand more about the input
arguments.

You can also use a database to create a CAN message. Refer to Using a CAN
Database for more information.

Pack a Message

After you define the message, pack it with the required data.

1 Use the pack function to pack your message with these input parameters:
pack (messageout, 25, 0, 16, 'LittleEndian')

Here you are specifying the data value to be 25, the start bit to be 0, the
signal size to be 16, and the byte order to be little-endian format.

2 To see the packed data, type:
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messageout

MATLAB displays your message properties with the specified data:

messageout =

can.Message handle
Package: can

Properties:
ID: 500
Extended: 0
Name: "'
Database: []
Error: O
Remote: O

Timestamp: O
Data: [25 0 0 0 0 0 0 O]
Signals: []

Methods, Events, Superclasses

The only field that changes after you specify the data is Data. Refer to the
pack function to understand more about the input arguments.

Transmit a Message

After you define the message and pack it with the required data, you are
ready to transmit the message. For this example, use canch to transmit the
message.

1 Use the transmit function to transmit the message, supplying the channel
and the message as input arguments:

transmit(canch1, messageout)

2 To display the channel status, type:

canchi

MATLAB displays the updated status of the channel:
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Summary of CAN Channel using 'Vector' 'CANcaseXL 1' Channel 1.

Channel Parameters:

Status:

Filter History:

Bus Speed is 250000.

Bus Status is 'ErrorPassive'.

Transceiver name is 'CANpiggy 251mag (Highspeed)'.
Serial Number of this device is 24811.
Initialization access is allowed.

No database is attached.

Online.
1 messages available to RECEIVE.
1 messages transmitted since last start.

0 messages received since last start.

Standard ID Filter: Allow All | Extended ID Filter: Allow All.

In the Status section, messages transmitted since last start count
increments by 1 each time you transmit a message.

Refer to the transmit function to understand more about the input

arguments.

Receive a Message

After your channel is online, use the receive function to receive available
messages. For this example, receive the message on the second configured
channel object, canch2.

1 To see messages available to be received on this channel, type:

canch2

The channel status displays available messages:

Status: Online.

1 messages available to RECEIVE.

0 messages transmitted since last start.

0 messages received since last start.
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2 To receive one message from canchi1 and store it as messagein, type:
messagein = receive(canch2, 1)
MATLAB returns the received message properties:
messagein =

can.Message handle
Package: can

Properties:
ID: 500
Extended: 0
Name: "'
Database: []
Error: O
Remote: O

Timestamp: 709.0403
Data: [25 0 0 0 0 0 0 O]
Signals: []

Methods, Events, Superclasses

3 To check if the channel received the message, type:

canch2

MATLAB returns the channel properties, and the status indicates that
the channel received one message:

Status: Online.
0 messages available to RECEIVE.
0 messages transmitted since last start.
1 messages received since last start.

Refer to the receive function to understand more about its input arguments.
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Unpack a Message

After your channel receives a message, specify how to unpack the message
and interpret the data in the message. Use unpack to specify the parameters
for unpacking a message:

value = unpack(messagein, 0, 16, 'LittleEndian', 'int16')
The unpacked message returns a value based on your parameters:

value =
25

Refer to the unpack function to understand more about its input arguments.

Save and Load a CAN Channel

® “Saving a CAN Channel Object to a MATLAB File” on page 1-25
® “Load a Saved Channel” on page 1-25

Saving a CAN Channel Object to a MATLAB File

You can save a CAN channel object to a file using the save function anytime
during the CAN communication session.

For example, create a channel object canch1. To save it to the MATLAB
file mycanch.mat, type:

save mycanch.mat canch1

Load a Saved Channel

If you have saved a CAN channel as a MATLAB file, you can load it into a
session using the load function. For example, to reload mycanch.mat created
above, type:

load mycanch.mat

The loaded CAN channel object reconnects to the specified hardware and
reconfigures itself to the specifications when the channel was saved.
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Filter Messages

You can set up filters on your channel to accept messagees based on the
filtering parameters you specify. Set up your filters before putting your
channel online. For more information on message filtering, see these
functions:

o filterAllowAll
e filterBlockAll
e filterAlowOnly

To specify message names you want to filter, create a CAN channel and attach
a database to the channel:

canchi=(Vector', 'CANcaseXL 1',1);
canch1.Database=("'demoVNT_CANdbFiles.dbc');

Set a filter for the message EngineMsg and display the channel:

filterAllowOnly(canch1, 'EngineMsg');

canch1i

Summary of CAN Channel using 'Vector' 'CANcaseXL 1' Channel 1.

Channel Parameters: Bus Speed is 500000.
Bus Status is 'N/A".
Transceiver name is ''

Serial Number of this device is 0.

Initialization access is allowed.

'demoVNT_CANdbFiles.dbc' database is attached.

Status: Offline - Waiting for start.
0 messages available to receive.
0 messages transmitted since last start.

0 messages received since last start.

Filter History: Standard ID Filter: Allow Only | Extended ID Filter: Allow All

If you start the channel and receive messages, you should now only see the
EngineMsg pass through the filter.
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Multiplex Signals

Use multiplexing to represent multiple signals in one signal’s location in a
CAN message’s data. A multiplexed message can have three types of signals:

Standard signal
This signal is always active. You can create one or more standard
signals.

Multiplexor signal
Also called the mode signal, it is always active and its value determines
which multiplexed signal is currently active in the message data. You
can create only one multiplexor signal per message.

Multiplexed signal
This signal is active when its multiplex value matches the value of the
multiplexor signal. You can create one or more multiplexed signals in
a message.

Multiplexing works only with a CAN database with message definitions that
already contain multiplex signal information. This example shows you how to
access the different multiplex signals using a database constructed specifically
for this purpose. This database has one message with these signals:

® SigA: A multiplexed signal with a multiplex value of 0.

® SigB: Another multiplexed signal with a multiplex value of 1.

® MuxSig: A multiplexor signal, whose value determines which of the two

multiplexed signals are active in the message.

1 Create a CAN database:

d = canDatabase('Mux.dbc')

Note This is an example database constructed for creating multiplex
messages. To try this example, use your own database.

2 Create a CAN message:

m = canMessage(d, 'Msg')
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The message displays all its properties:

m =

can.Message handle
Package: can

Properties:
ID: 250
Extended: 0O
Name: 'Msg’
Database: [1x1 can.Database]
Error: 0O
Remote: O

Timestamp: 0O
Data: [0 0 0 0 0 0 0 0]
Signals: [1x1 struct]

Methods, Events, Superclasses

3 To display the signals, type:

m.Signals
ans =
SigB: 0
SigA: 0
MuxSig: O

MuxSig is the multiplexor signal, whose value determines which of the
two multiplexed signals are active in the message. SigA and SigB are the
multiplexed signals that are active in the message if their multiplex values
match MuxSig. In the example shown, SigA is active because its current
multiplex value of 0 matches the value of MuxSig (which is 0).

4 If you want to make SigB active, change the value of the MuxSig to 1:
m.Signals.MuxSig = 1
To display the signals, type:

m.Signals
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ans =
SigB: 0
SigA: O
MuxSig: 1

SigB is now active because its multiplex value of 1 matches the current
value of MuxSig (which is 1).

5 Change the value of MuxSig to 2:

m.Signals.MuxSig = 2

Here, neither of the multiplexed signals are active because the current
value of MuxSig does not match the multiplex value of either SigA or SigB.

m.Signals
ans =
SigB: O
SigA: O
MuxSig: 2

Always check the value of the multiplexor signal before using a multiplexed
signal value.

if (m.Signals.MuxSig == 0)
% Feel free to use the value of SigA however is required.
end

This ensures that you are not using an invalid value because the toolbox
does not prevent or protect reading or writing inactive multiplexed signals.

Note You can access both active and inactive multiplexed signals regardless
of the value of the multiplexor signal.

Refer to the canMessage function to learn more about creating messages.
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Configure Silent Mode

The SilentMode property of a CAN channel specifies that the channel can
only receive messages and not transmit them. Use this property to observe all
message activity on the network and perform analysis without affecting the
network state or behavior. See SilentMode for more information.

1 Create a CAN channel object canch and display its properties:

get(canch1i)

MATLAB displays all properties on the configured channel:

General Settings:
BusStatus = 'N/A'
Database = []
InitializationAccess = 1
MessageReceivedFcn = []
MessageReceivedFcnCount = 1
MessagesAvailable = 0
MessagesReceived = 0
MessagesTransmitted =
ReceiveErrorCount = 0
Running = 0
SilentMode = 0
TransmitErrorCount = 0

0

Device Settings:
Device = 'CANcaseXL 1'
DeviceChannellIndex = 1
DeviceSerialNumber = 24811
DeviceVendor = 'Vector'

Transceiver Settings:
TransceiverName = 'CANpiggy 251mag (Highspeed)'
TransceiverState = 16

Bit Timing Settings:
BusSpeed = 500000
SJw = 1
TSEG1 = 4
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TSEG2 = 3
NumOfSamples = 1

2 Change the SilentMode property of the channel to true:

canchi1.SilentMode = true

3 To see the changed property value, type:

get(canch1i)

MATLAB displays all properties on the configured channel as before, with
the changed SilentMode property value:

SilentMode = 1

Disconnect Channels and Clean Up

® “Disconnecting the Configured Channel” on page 1-31
¢ “Clean Up the MATLAB Workspace” on page 1-32

Disconnecting the Configured Channel

When you no longer need to communicate with your CAN bus, disconnect the
CAN channel that you configured. Use the stop function to disconnect.

1 Stop the first channel:

stop(canchi)

2 Check the channel status:

canch1

MATLAB displays the channel status:
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Status: Offline - Waiting for START.
1 messages available to RECEIVE.
1 messages transmitted since last start.

0 messages received since last start.

3 Stop the second channel:

stop(canch2)
4 Check the channel status:
canch2

MATLAB displays the channel status:

Status: Offline - Waiting for START.
0 messages available to RECEIVE.
0 messages transmitted since last start.

1 messages received since last start.

Clean Up the MATLAB Workspace

When you no longer need the objects you used, remove them from the
MATLAB workspace. To remove channel objects and other variables from the
MATLAB workspace, use the clear function.

1 Clear the first channel:

clear canchi

2 Clear the second channel:

clear canch?2

3 Clear the CAN messages:
clear('messageout', 'messagein')

4 Clear the unpacked value:
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clear value
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Accessing the Toolbox

1-34

In this section...

“Explore the Toolbox” on page 1-34
“Get Help” on page 1-34

“View Examples” on page 1-34

Explore the Toolbox

You can access Vehicle Network Toolbox from the MATLAB Command
Window directly by using any Vehicle Network Toolbox function. To see a list
of all the functions available, type:

help vnt

Get Help

The toolbox functions are grouped by usage. Click a specific function for more
information.

To access the online documentation for the Vehicle Network Toolbox, type:

doc vnt

To access the reference page for a specific function, type:

doc function_name

View Examples

To follow examples in this guide use the Vector CANcaseXL device, with the
Vector XL Driver Library version 6.4 or later. The Examples index in the
Help browser lists these examples.
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o “Vector CAN Database Support” on page 2-2
® “Load and Create Messages With a .dbc File” on page 2-3
® “Other Uses of the CAN Database” on page 2-17
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Vector CAN Database Support

A CAN database contains physical message and signal definitions. Using
a CAN database, you can represent message and signal information in
engineering units and do need not manipulate raw data bytes. You can use
a Vector CAN database with Vehicle Network Toolbox. A .dbc file contains
definitions of CAN messages and signals.

Look up message and signal information and build messages using the
information defined in the database file.
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Load and Create Messages With a .dbc File

In this section...
“Load the CAN Database” on page 2-3
“Create a CAN Message” on page 2-4

“Access Signals in the Constructed CAN Message” on page 2-4
“Add a Database to a CAN Channel” on page 2-5
“Update Database Information” on page 2-5

“Create and Process Messages Using Database Definitions” on page 2-5

Load the CAN Database

To use a CAN database file, load the database into your MATLAB session. At
the MATLAB command prompt, type:

db = canDatabase('filename.dbc')

Here db is a variable you chose for your database handle and filename.dbc is
the actual file name of your CAN database. If your CAN database is not in the
current working directory, type the path to the database:

db = canDatabase('path\filename.dbc")

Tip CAN database file names containing non-alphanumeric characters such
as equal signs, ampersands, and so forth are incompatible with Vehicle
Network Toolbox. You can use periods in your database name. Rename any
CAN database files with non-alphanumeric characters before you use them.

This command returns a database object that you can use to create and
interpret CAN messages using information stored in the database. Refer to
the canDatabase function for more information.
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Create a CAN Message

This example shows you how to create a message using a database
constructed specifically for a demo. You can access this database in the
Toolbox > VNT > VNTDemos subfolder in your MATLAB installation
folder. This database has a message, EngineMsg. To try this example, create
messages and signals using definitions in your own database.

1 Create the CAN database object:
d = canDatabase('demoVNT_CANdbFiles.dbc')
2 Create a CAN message using the message name in the database:

message = canMessage(d, 'EngineMsg')

Access Signals in the Constructed CAN Message

You can access the two signals defined for the message you created in the
example database, message. You can also change the values for some signals.

1 To display signals in your message, type:
sig = (message.Signals)
Signals in the message are displayed as follows:
sig =

VehicleSpeed: 0O
EngineRPM: 250

2 Change the value of the EngineRPM signal:
message.Signals.EngineRPM = 300

3 Display signal information again to see the change:
sig
sig =

VehicleSpeed: 0
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EngineRPM: 300

Add a Database to a CAN Channel
To add a database to the CAN channel canch, type:

canch.Database = canDatabase('Mux.dbc')

For more information, see the Database property.

Update Database Information
When you make changes to a database file:

1 Reload the database file into your MATLAB session using the canDatabase
function.

2 Reattach the database to messages using the attachDatabase function.
Create and Process Messages Using Database

Definitions

This example shows you how to create, receive and process messages using
information stored in CAN database files. This example uses the CAN
database file, |demoVNT_CANdbFiles.dbc]|.

Copyright 2008-2011, The MathWorks, Inc.

Open the Database File

Open the database file and examine the Messages property to see the names
of all message defined in this database.

db = canDatabase('demoVNT_CANdbFiles.dbc"')
db.Messages
db =

can.Database handle
Package: can
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Properties:
Name: 'demoVNT_CANdbFiles'
Path: 'C:\Work\2011.10.20_Sandbox\matlab\toolbox\vnt\vntdemos\demoV
Messages: {5x1 cell}
UserData: []

ans
‘DoorControlMsg’
'EngineMsg'’
‘SunroofControlMsg'

'TransmissionMsg'
‘WindowControlMsg'

View Message Information

Use messageInfo to view message information, including the identifier, data
length, and a signal list.

messageInfo(db, 'EngineMsg')

ans =

Name: 'EngineMsg'

Comment: '
ID: 100

Extended: 0O

Length: 8

Signals: {2x1 cell}

You can also query for information on all messages at once.

messageInfo(db)
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ans =

5x1 struct array with fields:

Name
Comment
ID
Extended
Length
Signals

View Signal Information

Use signallnfo to view signal definition information, including type, byte
ordering, size, and scaling values that translate raw signals to physical values.

signalInfo(db,

ans =

Name :
StartBit:
SignalSize:
ByteOrder:
Signed:
ValueType:
Class:
Factor:
Offset:
Minimum:
Maximum:
Units:
Comment:
Multiplexor:
Multiplexed:
MultiplexMode:

'"EngineMsg’,

"EngineRPM")

'EngineRPM'
0

32
‘LittleEndian'
0

‘Integer’
‘uint32'
0.1000

250

250

9500

‘rpm’

o O o

You can also query for information on all signals in the message at once.
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signalInfo(db, 'EngineMsg')

ans =

2x1 struct array with fields:
Name
StartBit
SignalSize
ByteOrder
Signed
ValueType
Class
Factor
Offset
Minimum
Maximum
Units
Comment
Multiplexor
Multiplexed
MultiplexMode

Create a Message Using Database Definitions
Specify the name of the message when you create a new message to have the

database definition applied. CAN signals in this messages are represented in
engineering units in addition to the raw data bytes.

msgEngineInfo = canMessage(db, 'EngineMsg')

msgEngineInfo

can.Message handle
Package: can

Properties:
ID: 100
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Extended: O
Name: 'EngineMsg'
Database: [1x1 can.Database]
Error: O
Remote: O
Timestamp: O
Data: [0 00 0 0 0 0 0]
Signals: [1x1 struct]
UserData: []

View Signal Information
Use the Signals property to see signal values for this message. You can

directly write to and read from these signals to pack or unpack data from
the message.

msgEnginelInfo.Signals

ans =
VehicleSpeed: 0
EngineRPM: 250
Change Signal Information

Write directly to the signal to change a value and read its current value back.

msgEnginelInfo.Signals.EngineRPM = 5500.25
msgEngineInfo.Signals

msgEngineInfo =

can.Message handle
Package: can
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Properties:
ID: 100
Extended: O

Name: 'EngineMsg'
Database: [1x1 can.Database]
Error: O
Remote: O
Timestamp: O
Data: [23 205 0 0 0 0 O O]
Signals: [1x1 struct]
UserData: []

ans =

VehicleSpeed: 0
EngineRPM: 5.5003e+03

When you write directly to the signal, the value is translated, scaled, and
packed into the message data using the database definition.

msgEnginelInfo.Signals.VehicleSpeed = 70.81
msgEnginelInfo.Signals
msgEngineInfo =

can.Message handle
Package: can

Properties:
ID: 100
Extended: O

Name: 'EngineMsg’
Database: [1x1 can.Database]
Error: O
Remote: O
Timestamp: O
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Data: [283 205 0 0 71 0 0 O]
Signals: [1x1 struct]
UserData: []

ans =

VehicleSpeed: 71
EngineRPM: 5.5003e+03

Receive Messages with Database Information

Attach a database to a CAN channel that receives messages to apply database
definitions to incoming messages automatically. The database decodes only
messages that are defined. All other messages are received in their raw form.

rxCh = canChannel('Vector', 'Virtual 1', 2);
rxCh.Database = db

rxCh =
Summary of CAN Channel using 'Vector' 'Virtual 1' Channel 2.

Channel Parameters: Bus Speed is 500000.
Bus Status is 'N/A'.
Transceiver name 1is
Serial Number of this device is O.
Initialization access is allowed.
"demoVNT_CANdbFiles.dbc' database is attached.

Status: Offline - Waiting for start.
0 messages available to receive.
0 messages transmitted since last start.
0 messages received since last start.

Filter History: Standard ID Filter: Allow All | Extended ID Filter:
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Receive Messages

Start the channel, generate some message traffic and receive messages with
physical message decoding.

start(rxCh);
generateMsgsDDb() ;
rxmMsg = receive(rxCh, Inf)

rxmsg =

1x413 can.Message handle
Package: can

Properties:
ID
Extended
Name
Database
Error
Remote
Timestamp
Data
Signals
UserData

Stop the channel and clear it from the workspace.

stop(rxCh);
clear rxCh

Examine a Received Message

Inspect a received message to see the applied database decoding.

rxmsg(10)
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rxmMsg(10).Signals

ans =

can.Message handle

Package: can

Properties:

ID:
Extended:
Name:
Database:
Error:
Remote:
Timestamp:
Data:
Signals:
UserData:

ans =

100

0

"EngineMsg’

[1x1 can.Database]

0

0

0.1370

[34 131 0 0 52 0 0 O]
[1x1 struct]

[]

VehicleSpeed: 52
EngineRPM: 3607

Extract Most Recent Message by Name

Use extractRecent and specify a message name to extract the most recent
occurrance of a message.

msgRecentWindows = extractRecent(rxMsg, 'WindowControlMsg')

msgRecentWindows

can.Message handle

Package: can
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Properties:

ID:
Extended:
Name:
Database:
Error:
Remote:
Timestamp:
Data:
Signals:
UserData:

600

0
'WindowControlMsg'
[1x1 can.Database]
0

0

5.5373

[62 68 0 0]

[1x1 struct]
[]

Extract All Instances of a Specified Message by Name

Use extractAll and specify a message name to extract all instances of a
specified message.

allMsgEngine

allMsgEngine

extractAll(rxMsg, 'EngineMsg')

1x222 can.Message handle

Package: ca

Properties:
ID
Extended
Name
Database
Error
Remote
Timestamp
Data
Signals
UserData

n
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Plot Physical Signal Values

Plot the values of database decoded signals over time. Reference the message
timestamps and the signal values in variables.

signals = [allMsgEngine.Signals]
plot([allMsgEngine.Timestamp], [signals.VehicleSpeed])
title('Vehicle Speed from EngineMsg', 'FontWeight', 'bold')
xlabel('Timestamp')

ylabel('Vehicle Speed')

axis([0 6 0 75])

signals =
1x222 struct array with fields:

VehicleSpeed
EngineRPM
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Vehicle Speed from EngineMsy

3]
[
T

-
=
T

“ehicle Speed

[ ]
[

o]
=

—
]

f

] 1 1 1 1
0 1 2 3 4

Tirmestamp

2-16



Other Uses of the CAN Database

Other Uses of the CAN Database

In this section...

“View Message Information in a CAN Database” on page 2-17
“View Signal Information in a CAN Message” on page 2-18

“Attach a CAN Database to Existing Messages” on page 2-19

View Message Information in a CAN Database

You can look up information on message definitions by a single message by
name, or a single message by ID. You can also look up information on all
message definitions in the database by typing:

msgInfo = messageInfo(database name)

This command returns the message structure of information about messages
in the database. For example:

msgInfo =

5x1 struct array with fields:
Name
Comment
ID
Extended
Length
Signals

To get information on a single message by message name, type:
msgInfo = messageInfo(database name, 'message name')

This command returns information about the message as defined in the
database. For example:

msgInfo = messageInfo(db, 'EngineMsg')

msgInfo =
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Name: 'EngineMsg’

Comment: '
ID: 100

Extended: O

Length: 8

Signals: {2x1 cell}

Here the function returns information about message with name EngineMsg
in the database db. You can also use the message ID to get information
about a message. For example, to view the example message given here by
inputting the message 1D, type:

msgInfo = messageInfo(db, 100, false)

This command provides the database name, the message ID, and a Boolean
value for the extended value of the ID.

To learn how to use it and work with the database, see the messageInfo
function.

View Signal Information in a CAN Message

You can get signal definition information on a specific signal or all signals in a
CAN message with database definitions attached. Provide the message name
or the ID as a parameter in the command:

sigInfo = signalInfo(db, 'EngineMsg')

You can also get information about a specific signal by providing the signal
name:

sigInfo = signalInfo(db, 'EngineMsg', 'EngineRPM')

To learn how to use this property and work with the database, see the
signalInfo function.

You can also access the Signals property of the message to view physical
signal information. When you create physical signals using database
information, you can directly write to and read from these signals to pack or
unpack data from the message. When you write directly to the signal name,
the value is translated, scaled, and packed into the message data.
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Attach a CAN Database to Existing Messages

You can attach a .dbc file to messages and apply the message definition
defined in the database. Attaching a database allows you to view the
messages in their physical form and use a signal-based interaction with the
message data.

To attach a database to a message, type:

attachDatabase (message name, database name)

Note If your message is an array, all messages in the array are associated
with the database that you attach.

You can also dissociate a message from a database so that you can view the
message in its raw form. To clear the attached database from a message, type:

attachDatabase (message name, [])

Note The database gets attached even if the database does not find the
specified message. Even though the database is still attached to the message,
the message is displayed in its raw mode.

For more information, see the attachDatabase function.
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e “CAN Tool” on page 3-2
e “Using the CAN Tool” on page 3-9
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CAN Tool

In this section...

“About the CAN Tool” on page 3-2
“Opening the CAN Tool” on page 3-2
“CAN Tool Fields” on page 3-2

About the CAN Tool

Vehicle Network Toolbox provides a graphical user interface that monitors
CAN message traffic on selected channels. Using the CAN Tool you can:

® view live CAN message data.

® (Configure connection to the CAN bus.

* View unique messages.

Attache a database to view signal information.

Save the messages to a log file.

You can

Opening the CAN Tool
To open the CAN Tool, type canTool in the MATLAB Command Window.

CAN Tool Fields

The tool has the following menus, buttons and table.



CAN Tool

File Menu

* Save Messages — Saves messages to a log file.
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® (Clear Messages — Clears messages in the CAN Tool window.

e Exit — Click to exit the CAN Tool window.

Configure Menu
¢ Channel — Displays all available CAN devices and channels on your
system. Select the CAN channel to monitor.

®* Bus Speed — Opens the Specified bus speed dialog box. To change the
bus speed of the selected channel, type the new value in bits per second in
the box.

il

Entar the bus s in_bits par second:

Ok Cancel |

® Message Filters — Opens the Set Message Filters dialog box. Select an
option in the dialog box to configure hardware filters to block or allow
messages.
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| Set Message Filters o ] S

— Standard Mes=sage ID Filter
= Allow Al

" Block Al

" Allow Only  [0:2047

— Extended Mes=age ID Filter
&+ Allow Al

i~ Block &l

" Allow Only  [1:526570911

Ok Cancel

= Standard Message ID Filter
« Allow All — Select to allow all standard ID messages.
Block All — Select to block all standard ID messages.

« Allow only — Select to set up custom filtering of messages. Type the
standard message IDs that you want to allow.

= Extended Message ID Filter
« Allow All — Select to allow all extended ID messages.
Block All — Select to block all extended ID messages.

« Allow only — Select to set up custom filtering of messages. Type the
extended message IDs that you want to allow.

* Database — Selects the database to attach to the CAN messages on the
selected channel.

Run Menu

e Start — Click to view message activity on the selected channel.
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e Pause — Click to pause the display of message activity on the selected
channel.

® Stop — Click to stop the display of message activity on the selected
channel.

View Menu

¢ Maximum message count — Opens the Specify maximum message count
dialog box. To change the maximum number of messages displayed at a
time in the CAN Tool, type the new value in the box.

IIEY

Entar the maximum number of massagas to display as
a value betwesn 50 and 5000

0K Cancel

¢ Number Format — Select the number format to display message
identifier data. Choose Hexadecimal or Decimal.

¢ Show Unique Messages — Select this option to display the most recent
instance of each message received on the selected channel. If you select
this option, the tool displays a simplified version of the message traffic. In
this view, messages do not scroll up, but each message refreshes its data
with each timestamp. If you do not select this option, the tool displays all
instances of all messages in the order that the selected channel receives
them.

Help Menu

e canTool Help — Select this option to see the online help for CAN Tool.

®* About Vehicle Network Toolbox — Select this option to view the toolbox
version and release information.
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Buttons

®

Displays message activity on the selected channel.

Pause @

Pauses the display of message activity on the selected channel.

®

Stops displaying messages on the selected channel.

Save messages =l
Click this button to save the current message list on the selected
channel to a file.

Start

Stop

Clear messages

Click this button to clear messages in the CAN Tool window.

B

Show unique messages =2
Select this option to display the most recent instance of each message
received on the selected channel. If you select this option, the tool
displays a simplified version of the message traffic. In this view,
messages do not scroll up, but each message refreshes its data with each
timestamp. If you do not select this option the tool displays all instances
of all messages in the order that the selected channel receives them.

Docking ™
Click this button to dock the CAN Tool to the MATLAB desktop. To
undock, click this button - |

Undocking i

Click this button to undock the CAN Tool from the MATLAB desktop.
To dock, click this button. ﬂ
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Message Table

Timestamp

Displays the time, relative to the start time, that the device receives the
message. The start time begins at 0 when you click Start.

ID

Displays the message ID. This field displays a number in hexadecimal
format for the ID and:

¢ Displays numbers only for standard IDs.

® Appends an x for an extended ID.

¢ Displays an r for a remote frame.

¢ Displays error for messages with error frames.

To change the format to decimal, select View > Number
Format > Decimal.

Name

Displays the name of the message, if available.
Length

Displays the length of the message in bytes.

Data
Displays the data in the message in hexadecimal format.

To change the format to decimal, select View > Number
Format > Decimal.

If you are using a database, click the + sign to see signal information. The tool
displays the signal name and the physical value of the message, as defined in
the attached database.
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Using the CAN Tool

In this section...

“Viewing Messages on a Channel” on page 3-9
“Configuring the Channel Bus Speed” on page 3-9
“Filtering CAN Messages in the CAN Tool” on page 3-10
“Attaching a Database” on page 3-11

“Changing the Message Count” on page 3-13

“Changing the Number Format” on page 3-13

“Viewing Unique Messages” on page 3-13

“Saving the Message Log File” on page 3-14

Viewing Messages on a Channel

1 Open the CAN Tool and select the device and channel connected to your
CAN bus by selecting Configure > Channel.

2 The CAN Tool defaults to the bus speed set in the device driver. You can
also configure a new bus speed. See Configuring the Channel Bus Speed

3 Click Start, or select Run > Start.
4 To pause the display, click Pause or select Run > Pause.

5 To stop the display, click Stop or select Run > Stop.

Configuring the Channel Bus Speed

Configure the bus speed when your network speed differs from the default
value of the channel. You require initialization access for the channel to
configure the bus speed.

To configure a new bus speed:

1 Select Configure > Bus Speed.
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2 Type the desired value in the Specify bus speed dialog box.
3 Click OK.

The value you set takes effect once you start the CAN channel. If an error
occurs when applying the new bus speed, the value reverts to the default
value specified in the hardware.

Filtering CAN Messages in the CAN Tool
Filter CAN messages to allow or block messages displayed in the CAN Tool.

To set up filters:

1 Select Configure > Message Filters.

2 To set filters on standard message IDs, select:

a Allow All to set the hardware filter to allow all messages with standard
IDs.

b Block All to set the hardware filter to block all messages with standard
IDs.

¢ Allow Only to set up custom filters. Type the standard IDs of the
message you want to filter. You can type a range or single IDs. The
default is 0:2047.
3 To set filters on extended message IDs, select:
a Allow All to set the hardware filter to allow all messages extended IDs.

b Block All to set the hardware filter to block all messages extended IDs.

¢ Allow Only to set up custom filters. Type the extended IDs of the
message you want to filter. You can type a range or single IDs. The
default is 0:536870911.

Note If you are using a custom filter, change the default range to the
desired range. The default range allows all messages and you should
select Allow All to allow all incoming messages with extended IDs.
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4 Click OK.

Attaching a Database
Attach a database to the CAN Tool to see signal information of the displayed

messages.

1 Select Run > Stop to stop the message display in the CAN Tool.

2 Select Configure > Database.

3 Select the database to attach and start the message display again.

When the tool displays the messages, it shows the message name in the

Message table.
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4 Click the plus (+) sign to see the details of the message.
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4,987063 Y T— 54 6C 45 32
[=] 4.986085 1F4 TestMessage 4 AEB47105
|_ Signal Mame Physical Value
Sigl 174.000000
Sig2 130,000000
Sig3 113.000000
Sigd 5.000000

The tool displays the signal name as defined in the attached database and
the signal’s physical value.

Changing the Message Count

You can change the maximum number of messages displayed to a value from
100 through 5000.

1 Select View > Maximum Message Count.

2 In the Specify maximum message count dialog box, type the number of
messages you want displayed at one time.

3 Click OK.

Changing the Number Format

By default the message data is displayed in hexadecimal format. To change
the display to decimal format, select View > Number Format > Decimal.

Viewing Unique Messages

To view the most recent instance of each unique message received on the
channel, select View > Show Unique Messages. In this view, you do not
see messages scroll up, but each message refreshes its data and timestamp

Sl
with each new instance. You can also click = ==,
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) canTool | Vector - CANcaseXL 1 - Channel 1 | Started - 500 kbps _|D|ﬂ
File Configure Run View Help £
BE@O|HO|®

Timestamp D Mame Length Data
11.575509 DE 94 8C 25

11.570291 2EE 8 JAESZYD3BIFEL..

Use this feature to get a snapshot of message IDs that the selected channel
receives. Use this information to analyze specific messages.

When you select Show Unique Messages, the tool continues to receive
message actively. This simplified view allows you to focus on specific
messages and analyze them.

To save messages when Show Unique Messages is selected, click Pause
and then click Save. You cannot save just the unique message list. This
operation saves the complete message log in the window.

Saving the Message Log File

You can save a log file of the messages currently displayed while the tool is
running. You need not stop or pause the display to save a log file.

To save a log file of the messages currently displayed in the window, select

File > Save Messages or click = .

The tool saves the messages in a MATLAB file in your current working folder
by default. You can change the location by browsing to a different folder in
the Save dialog box.

Each time you save the message log to a file, the CAN Tool saves them as VNT
CAN Log.mat with sequential numbering by default. You can change the
name by typing a new name in Save dialog box.
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* “Overview” on page 4-2
¢ “CAN Communication in Simulink” on page 4-3
® “Opening the Vehicle Network Toolbox Block Library” on page 4-7

e “Building Simulink Models to Transmit and Receive Messages” on page
4-10

e “Create Custom Blocks” on page 4-25
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Overview

This chapter describes how to use the Vehicle Network Toolbox block library.
The library contains these blocks:

® CAN Configuration — Configure the settings of a CAN device.

® CAN Log— Logs messages to file.

® CAN Pack — Pack signals into a CAN message.

® CAN Receive — Receive CAN messages from a CAN bus.

® CAN Replay— Replays logged messages to CAN bus or output port.
® CAN Transmit — Transmit CAN messages to a CAN bus.

® CAN Unpack — Unpack signals from a CAN message.

The Vehicle Network Toolbox block library is a tool for simulating message

traffic on a CAN network, as well for using the CAN bus to send and receive
messages. You can use blocks from the block library with blocks from other
Simulink libraries to create sophisticated models.

To use the Vehicle Network Toolbox block library, you require Simulink,

a tool for simulating dynamic systems. Simulink is a model definition
environment. Use Simulink blocks to create a block diagram that represents
the computations of your system or application. Simulink is also a model
simulation environment. Run the block diagram to see how your system
behaves. If you are new to Simulink, read the Simulink Getting Started Guide
in the Simulink documentation to understand its functionality better.

For more detailed information about the blocks in the Vehicle Network
Toolbox block library, see Block Reference.
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CAN Communication in Simulink

In this section...

“Message Transmission Workflow” on page 4-4

“Message Reception Workflow” on page 4-5
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Message Transmission Workflow

Add CAN Configure the channel to
transmit messages from your

Configuration block| . o0jication

A4

Add CAN Pack Pack the data
blocks

coming from your
source application

More than one Pack
block?

Refer to "Using Mux
Add Mux blocks |Blocks" section for
more information

h 4

.| Add CAN Transmit
blocks

Transmission
model complete

This workflow represents the most common CAN Transmit model. Adjust
your model as needed. For more workflow examples, see “Building Simulink
Models to Transmit and Receive Messages” on page 4-10 and the Vehicle
Network Toolbox demos.
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Using Mux Blocks

e Use a Mux block to combine every message from the source if they are
transmitted at the same rate.

¢ Use one CAN Transmit block for each configured Mux block.

Message Reception Workflow

Add CAN Configure the channel to
Configuration block, receive messages

h

Add one CAN Set :’nessage I?Iters
Receive block o pass only
relevant messages

h

Invoke a function-call triggered
Add Function-Call | subsystem to execute when the
Subsystem block CAMN Receive block receives a

Refer to new message at a given timestep

"Downstream Processing”
section for more information.

k4

Add the CAN Unpack block inside
Add downstream Add CAN Unpack | e oo can subsystem
process blocks block

Receive model
complete

For workflow examples, see “Building Simulink Models to Transmit and
Receive Messages” on page 4-10 and the Vehicle Network Toolbox demos.

Message Filtering
Set up filters to process only relevant messages. This ensures optimal
simulation performance.

Do not set up filters if you need to parse all bus communications.
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Function-Call Triggered Message Processing
Set up your CAN Unpack block:

¢ In a function-call triggered subsystem if you want to unpack every message
received by your CAN Receive block.

® Without a function-call triggered subsystem if you want to unpack only the
most recent message received by your CAN Receive block.
Set up this system if your receive block is filtering for a single message.

Downstream Processing
For any downstream processing using received messages, include blocks:

e Within the function-call subsystem if your downstream process must
respond to all messages received in a single timestep in this model.

® Qutside the function-call subsystem if your downstream process responds
only to the most recent message received in a given timestep in this model.
In this case, the CAN Unpack block will not respond to any other messages
received, irrespective of the messages ID.



Opening the Vehicle Network Toolbox Block Library

Opening the Vehicle Network Toolbox Block Library

In this section...
“Using the MATLAB Command Window” on page 4-7

“Using the Simulink Library Browser” on page 4-8

Using the MATLAB Command Window
To open the Vehicle Network Toolbox block library, enter canlib in the
MATLAB Command Window.

MATLAB displays the contents of the library in a separate window.
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* . Library: canlib -0l x|
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2L > SR
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a CAN Log
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Ready 110% odeds

Using the Simulink Library Browser

To open the Vehicle Network Toolbox block library, start the Simulink Library
Browser from MATLAB. Then select the library from the list of available
block libraries displayed in the browser.

To start the Simulink Library Browser, enter simulink in the MATLAB
Command Window.



Opening the Vehicle Network Toolbox Block Library

The left pane lists available block libraries, with the basic Simulink library
listed first, followed by other libraries listed alphabetically under it. To open
the Vehicle Network Toolbox block library, click its icon and select CAN
Communication for the CAN blocks.

-iaix
File Edit View Help

0O = 22| | Enter search term 'l“
Libraries Library: Vehicle Network Toolbox/CAN Communication | Search Results: ‘l 4
- | EDA Simulator Link |

(- Embedded Coder .

& W Fuzzy Logic Toolbox — CAN Configuration

ﬂ Gauges Blockset
- ﬂ Image Acquisition Toolbox -
- Instrument Control Toolbox CAN Log
%8 Model Predictive Control Toolbox
& 18 Meural Metwork Toolbox

- OPC Toolbox CAN Pack

& 1 Physical Modeling Development
-1 Real-Time Windows Target
-1 Report Generator CAMN Receive
- 1| Robust Control Toolbox -
[+ SimEvents
- Simscape
- 1 Simulink 30 Animation .
B ﬂ Simulink Coder e
[]-ﬂ Simulink Control Design
[]-ﬂ Simulink Design Optimization -~
& 8 Simulink Design Verifier CAN Unpack
& B8 Simulink Extras

| Simulink Verification and Validation

- | Stateflow

- B System Identification Toolbox

Vehicle Network Toolbox
g CAN Communication

W xPC Target =

Showing: Vehicle Metwork Toolbox/CAN Communication

Simulink loads and displays the blocks in the library.
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Building Simulink Models to Transmit and Receive

Messages

In this section...

“Build a Message Transmit Model” on page 4-10
“Build a Message Receive Model” on page 4-15
“Save and Run the Model” on page 4-21

Build a Message Transmit Model
This section provides an example that builds a simple model using Vehicle

Network Toolbox blocks with other blocks in the Simulink library. This
example 1llustrates how to send data via a CAN network.

e Use virtual CAN channels to transmit messages.

e Use the CAN Configuration block to configure your CAN channels.

¢ Use the Constant block to send data to the CAN Pack block.

® Use the CAN Transmit block to send the data to the virtual CAN channel.
Use this section with “Build a Message Receive Model” on page 4-15 and
“Save and Run the Model” on page 4-21 to build your complete model and
run the simulation.

e “Step 1: Open the Block Library” on page 4-10

e “Step 2: Create a New Model” on page 4-11

e “Step 3: Drag Vehicle Network Toolbox Blocks into the Model” on page 4-12
e “Step 4: Drag Other Blocks to Complete the Model” on page 4-12

e “Step 5: Connect the Blocks” on page 4-13

e “Step 6: Specify the Block Parameter Values” on page 4-13

Step 1: Open the Block Library

To open the Vehicle Network Toolbox block library, start the Simulink Library
Browser by entering:



Building Simulink® Models to Transmit and Receive Messages

simulink

in the MATLAB Command Window. The left pane in the Simulink Library
Browser lists the available block libraries. To open the Vehicle Network
Toolbox block library, click its icon. Then click CAN Communication to
open the CAN blocks. See Using the Simulink Library Browser for more
information.

Step 2: Create a New Model

To use a block, add it to an existing model or create a model.

For this example, create a model by clicking the New model button on the
toolbar.

] simulink Library Browser =l

File Edit view Help

E'K’* »| | Enter search term ~ H
Libraries

Library: Vehicle Network Toolbox/CAN Communication | Search Results- 4| P

- 8| EDA Simulator Link |
& ¥ Embedded Coder

- 18 Fuzzy Logic Toolbox

- 1| Gauges Blockset

- 1| Image Acquisition Toolbox

- | Instrument Control Toolbox

- 18| Model Predictive Control Toolbox

-1 Neural Network Toolbox

- T OPC Toolbox .
- B8 Physical Modeling Development

- 1 Real-Time Windows Target

- 1| Report Generator

- 1| Robust Contral Toolbox

- W8 SimEvents

- W SimPowerSystems

- W/ SimRF

- W Simscape

- W Simulink 3D Animation

- W8/ Simulink Coder

- W Simulink Control Design

- W8/ Simulink Design Optimization

- W8/ Simulink Design Verifier

- W Simulink Extras

- 1| Simulink Verification and Validation
- 1§ Stateflow

- 1| System Identification Toolbox

= B Vehicle Network Toolbox

IR C A\l Communication
- 19 xPC Target hd
Showing: Vehicle Network Toolbox/CAN Communication

CAN Configuration

CAN Log

CAN Pack

CAN Receive

CAM Replay

CAM Transmit

CAN Unpack

PN O O O = = O = N = I =
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You can also select File > New > Model from the Simulink Library Browser.
Simulink opens an empty model window on the display. To name the new

model, use the Save option.

Step 3: Drag Vehicle Network Toolbox Blocks into the Model

To use the blocks in a model, click a block in the library and, holding the
mouse button down, drag it into the model window. For this example, you
need one instance each of the CAN Configuration, CAN Pack, and CAN

Tarnsmit blocks in your model.
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Step 4: Drag Other Blocks to Complete the Model

This example requires a source block that feeds data to the CAN Pack block.
Add a Constant block to your model.
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Step 5: Connect the Blocks

Make a connection between the Constant block and the CAN Pack block.
When you move the pointer near the output port of the Constant block, the
pointer becomes a cross hair. Click the Constant block output port and,
holding the mouse button, drag the pointer to the input port of the CAN Pack
block. Then release the button.

In the same way, make a connection between the output port of the CAN Pack
block and the input port of the CAN Transmit block.

The CAN Configuration block does not connect to any other block. This block
configures the CAN channel used by the CAN Transmit block to transmit
the packed message.

Step 6: Specify the Block Parameter Values
You set parameters for the blocks in your model by double-clicking the block.

Configure the CAN Configuration Block. Double-click the CAN
Configuration block to open its parameters dialog box. Set the:

® Device to Vector Virtual 1 (Channel 1)

* Bus speed to 500000

e Acknowledge Mode to Normal

Click OK.

Configure the CAN Pack Block. Double-click the CAN Pack block to open
its parameters dialog box. Set the:

* Data is input as to raw data

® Name to the default value CAN Msg

¢ Identifier type to the default Standard (11-bit identifier) type

¢ Identifier to 500

Length (bytes) to the default length of 8

Click OK.
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Configure the CAN Transmit Block. Double-click the CAN Transmit
block to open its parameters dialog box. Set Device to Vector Virtual 1
(Channel 1). Click Apply, then OK.

Configure the Constant Block. Double-click the Constant block to open its
parameters dialog box. On the Main tab, set the:

* Constant valueto[1 2 3 4 5 6 7 8]

e Sample time to 0.01 seconds
On the Signal Attributes tab, set the Output data type to uint8. Click OK.

Your model looks like this figure.

-inix]

File Edit View Display Diagram Simulation Analysis Code Tools Help

B e 0 B2 @6l ® D> = fwe [ormal | @ &~
Mode! Browser = CAN_Communication I
- %] CAN_Communication ®© | |"a|CAN_Communication -
@)
E3 Vector Virtual 1
Channel 1
= Bus speed. 500000
=) 'CAN Configuration
Message: CAN Msg Vedtor Virtual 1
11223456761 —pDats g Channel 1
Constant CAN Pack ‘CAN Transmit
«
Ready [100% oded5 7
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Build a Message Receive Model

This section provides an example that builds a simple model using the Vehicle
Network Toolbox blocks with other blocks in the Simulink library. This
example illustrates how to receive data via a CAN network.

e Use a virtual CAN channel to receive messages.
e Use the CAN Configuration block to configure your virtual CAN channels.

e Use the CAN Receive block to receive the message sent by the blocks built
in “Build a Message Transmit Model” on page 4-10.

¢ Use a Function—Call Subsystem block that contains the CAN Unpack
block. This function takes the data from the CAN Receive block and uses
the parameters of the CAN Unpack block to unpack your message data.

e Use a Scope block to show the transfer of data visually.

Use this section with “Build a Message Transmit Model” on page 4-10 and
“Save and Run the Model” on page 4-21 to build your complete model and
run the simulation.

e “Step 7: Drag Vehicle Network Toolbox Blocks into the Model” on page 4-15
® “Step 8: Drag Other Blocks to Complete the Model” on page 4-16

e “Step 9: Connect the Blocks” on page 4-18

e “Step 10: Specify the Block Parameter Values” on page 4-20

Step 7: Drag Vehicle Network Toolbox Blocks into the Model

For this example, you need one instance each of the CAN Configuration, CAN
Receive, and CAN Unpack blocks in your model. However, you add only the
CAN Configuration and the CAN Receive blocks here. Add the CAN Unpack
block into the Function—Call Subsystem described in “Step 8: Drag Other
Blocks to Complete the Model” on page 4-16.

Tip Configure a separate CAN channel for the CAN Receive and CAN
Transmit blocks.
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Step 8: Drag Other Blocks to Complete the Model
Use the Function—Call Subsystem block from the Simulink Ports &
Subsystems block library to build your CAN Message pack subsystem.
1 Drag the Function—Call Subsystem block into the model.
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2 Double-click the Function—Call Subsystem block to open the subsystem
model.
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3 Drop the CAN Unpack block from the Vehicle Network Toolbox block
library in this subsystem.
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To see the results of the simulation visually, drag the Scope block from the
Simulink block library into your model.

B e e

alot| i

Step 9: Connect the Blocks

1 Connect the CAN Msg output port on the CAN Receive block to the Inl
input port on the Function—Call Subsystem block.

Vector Virtual 1 P oot
Channel 1
Std. IDs: all .
Ext. 1Ds: all CAN Msg i Ini Outi
i S TR B
CAN Receive
A

Function-Call Subsystem

2 Open the Function—Call Subsystem block and:
® Double-click Inl to rename it to CAN Msg.

® Double-click Outl to rename it to data.
3 Rename the Function—Call Subsystem block to CAN Unpack Subsystem.

4 Connect the f() output port on the CAN Receive block to the function()
input port on the Function—Call Subsystem block.
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[

Vector Virtual 1 ) petiond
Channel 1
Std. D= all .
Ext. D= all CAN Msg ] Ini Outi
S N e BT
CAN Receive |
o rgack

Function-Call Subsystemn

5 Connect the CAN Unpack Subsystem output port to the input port on the
Scope block.

Your model looks like this figure.
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The CAN Configuration block does not connect to any other block. This

block configures the CAN channel used by the CAN Receive block to receive
the CAN message.
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Step 10: Specify the Block Parameter Values
Set parameters for the blocks in your model by double-clicking the block.

Configure the CAN Configuration1 Block. Double-click the CAN
Configuration block to open its parameters dialog box. Set the:

® Device to Vector Virtual 1 (Channel 2)
* Bus speed to 500000
¢ Acknowledge Mode to Normal

Click OK.

Configure the CAN Receive Block. Double-click the CAN Receive block to
open its Parameters dialog box. Set the:

® Device to Vector Virtual 1 (Channel 2)
¢ Sample time to 0.01

¢ Number of messages received at each timestep to all
Click OK.

Configure the CAN Unpack Subsystem. Double-click the CAN Unpack
subsystem to open the Function—Call Subsystem model. In the model,
double-click the CAN Unpack block to open its parameters dialog box. Set the:

* Data to be output as to raw data

¢ Name to the default value CAN Msg

Identifier type to the default Standard (11-bit identifier) type
Identifier to 500

Length (bytes) to the default length of 8

Click OK.

Your subsystem looks like this figure.
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Save and Run the Model

This section shows you how to save the models you built, “Build a Message
Transmit Model” on page 4-10 and “Build a Message Receive Model” on page
4-15.

e “Step 11: Save the Model” on page 4-22

e “Step 12: Change Configuration Parameters” on page 4-22

e “Step 13: Run the Simulation” on page 4-22

® “Step 14: View the Results” on page 4-23
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Step 11: Save the Model
Before you run the simulation, save your model by clicking the Save icon or
selecting File > Save from the menu bar.

Step 12: Change Configuration Parameters

1 In your model window, select Simulation > Model Configuration
Parameters. The Configuration Parameters dialog box opens.

2 In the Solver Options section, select:
¢ Fixed-step from the Type list.

* Discrete (no continuous states) from the Solver list.

Step 13: Run the Simulation

To run the simulation, click the Start button on the model window toolbar.
Alternatively, you can use the Simulation menu in the model window and
choose the Start option.

When you run the simulation, the CAN Transmit block gets the message from
the CAN Pack block. It then transmits it via Virtual Channel 1. The CAN
Receive block on Virtual Channel 2 receives this message and hands it to the
CAN Unpack block to unpack the message.

While the simulation is running, the status bar at the bottom of the model
window updates the progress of the simulation.
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Step 14: View the Results
Double-click the Scope block to view the message transfer on a graph.
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o
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If you cannot see all the data on the graph, click the Autosecale toolbar button,
which automatically scales both axes to display all stored simulation data.

o1 x]
sBLPL L AEE BaF -

In the graph, the horizontal axis represents the simulation time in seconds
and the vertical axis represents the received data value. In the Message
Transmit model, you configured blocks to pack and transmit an array of
constant values, [1 23 4 5 6 7 8], every 0.01 second of simulation time. In the
Message Receive model, these values are received and unpacked. The output
in the Scope window represents the received data values.
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Create Custom Blocks

You can create custom Receive and Transmit blocks to use with hardware
currently not supported by the Vehicle Network Toolbox.

Vehicle Network Toolbox blocks use a custom CAN data type. To use the
blocks you create with other Vehicle Network Toolbox blocks, register this
custom CAN data type.

To use the custom data type defined in the Vehicle Network Toolbox, write a
C/C++ S-function.

To register and use the custom CAN data type, in your S-function:
1 Include the can_datatype.h header located

in[MATLABROOT]\toolbox\vnt\vntblks\include\candatatype at the top
of the S-function:

#include "can_datatype.h"

Note The header can_message.h included by can_datatype.h is located
in [MATLABROOT]\toolbox\shared\can\src\scanutil\.

2 Link your S-function during build to the scanutil.lib located in the
[MATLABROOT]\toolbox\vnt\vntblks\1lib\<ARCH> directory. The shared
library scanutil.dll, is located in the [MATLABROOT]\bin\<ARCH>

3 Call this function in md1lInitializeSizes to initialize the custom CAN
data type:

mdlInitialize CAN_datatype(S);

4 Get custom data type ID using ssGetDataTypeld:

dataTypeID = ssGetDataTypelId(S,SL_CAN_MESSAGE_DTYPE_NAME) ;

5 Do one of the following:
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® To create a receive block, set output port data type to CAN_MESSAGE:

ssSetOutputPortDataType(S, portID, dataTypelD );

® To create a transmit block, set the input port to CAN_MESSAGE:

ssSetInputPortDataType(S, portID, dataTypeID );

For more information on S-functions, see “Overview of S-Functions” in the
Simulink User’s Guide.



Function Reference

CAN Channel Construction (p. 5-2)

CAN Channel Configuration (p. 5-3)

CAN Channel Execution (p. 5-4)

CAN Channel Status (p. 5-5)

CAN Database (p. 5-6)
CAN Message Handling (p. 5-7)

CAN Message Filtering (p. 5-8)

Information and Help (p. 5-9)

Graphical Tools (p. 5-10)
Vector Informatik (p. 5-11)

Functions related to constructing
CAN channel

Functions related to configuring
CAN channel

Functions related to executing
configured CAN channel.

Functions related to checking and
modifying CAN channel status

Functions related to CAN database

Functions related to working with
CAN messages

Functions related to setting up CAN
message filters

Functions related to displaying help
information

Functions related to CAN Tools

Functions specifically related to
Vector hardware functionality



5 Function Reference

CAN Channel Construction

canChannel Construct CAN channel connected
to selected device
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CAN Channel Configuration

CAN Channel Configuration

get Return property values

set Configure property values

5-3



S

Function Reference

5-4

CAN Channel Execution

transmitPeriodic

receive
replay
start
stop
transmit

transmitConfiguration

transmitEvent

Configure a message for periodic
transmit

Receive messages from CAN bus
Retransmit messages from CAN bus
Set CAN channel online

Set CAN channel offline

Send CAN messages to CAN bus

Display messages configured for
automatic transmit

Configure a message for event-based
transmit



CAN Channel Status

CAN Channel Status

configBusSpeed Set bit timing rate of CAN channel
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CAN Database

canDatabase
messageInfo

signallnfo

Create handle to CAN database file
Information about CAN messages

Information about signals in CAN
message



CAN Message Handling

CAN Message Handling

attachDatabase

canMessage
canMessagelImport
discard
extractAll
extractRecent
extractTime

pack

unpack

Attach CAN database to messages
and remove CAN database from
messages

Build CAN message based on
user-specified structure

Import CAN message log file from a
third-party vendor tool

Discard all messages from CAN
channel

Select all instances of message from
array of messages

Select most recent message from
array of messages

Select messages occurring within
specified time range from array of
messages

Pack signal data into CAN message

Unpack signal data from message
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CAN Message Filtering

filterAllowAll
filterAllowOnly
filterBlockAll
filterReset

filterSet

Allow all messages of specified
1dentifier type

Configure message filter to allow
only specified messages

Configure filter to block messages
with specified identifier type

Open CAN message acceptance
filters

Set specific CAN message acceptance
filter configuration



Information and Help

Information and Help

canHWInfo Information on available CAN
devices
canSupport Generate technical support log
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Graphical Tools

canTool Open CAN Tool
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Vector Informatik

Vector Informatik

filterAcceptRange

filterBlockRange

Set range of CAN identifiers to pass
acceptance filter

Set range of CAN identifiers to block
via acceptance filter
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attachDatabase

6-2

Purpose
Syntax

Description

Input
Arguments

Tips

Examples

See Also

Attach CAN database to messages and remove CAN database from
messages

attachDatabase (message, database)
attachDatabase (message, [])

attachDatabase (message, database) attaches the specified
database to the specified message. You can then use signal-based
interaction with the message data, interpreting the message in its
physical form.

attachDatabase (message, []) removes any attached database from
the specified message. You can then interpret messages in their raw
form.

message

The name of the CAN message that you want to attach the database
to or remove the database from.

database

Handle containing the database (.dbc file) that you want to attach to
the message or remove from the message.

If the specified message is an array, then the database attaches itself
to each entry in the array. The database attaches itself to the message
even if the message you specified does not exist in the database. The
message then appears and operates like a raw message. To attach the
database to the CAN channel directly, edit the Database property of
the channel object.

candb = canDatabase('C:\Database.dbc')
message = receive(canch, Inf)
attachDatabase(message, candb)

canDatabase | receive



canChannel

Purpose

Syntax

Description

Tips

Input
Arguments

Construct CAN channel connected to selected device

canch = canChannel('vendor', 'device', devicechannelindex)
canch = canChannel('vendor', 'devicenumber')
canch = canChannel('vendor', ‘'device', devicechannelindex)

returns a CAN channel connected to a device from a specified vendor.

For Vector products, device is a combination of the device type and a
device index, such as 'CANCaseXL 1'. For example, if there are two
CANcardXL devices, device can be 'CANcardXL 1' or 'CANcardXL 2'.

For National Instruments CAN devices, use canch =
canChannel('vendor', 'devicenumber'), where the vendor is the
literal string 'NI', and the devicenumber is the interface number
defined for the channel in NI Measurement & Automation Explorer.

® You cannot have more than one active connection to the same NI
device channel.

e Use canHWInfo to obtain a list of available devices.

vendor

The name of the CAN device vendor. Specify the vendor name as a
string.

device

The CAN interface that you want to connect to.

devicechannelindex

A numeric channel on the specified device.

canch

The CAN channel object the you create.
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Properties CAN Channel Properties

BusLoad
Database
MessageReceivedFcn

MessageReceivedFcnCount
Running
SilentMode

TransceiverName

TransceiverState

UserData

CAN Device Properties

Device

Device (NI)
DeviceChannelIndex
DeviceSerialNumber

DeviceVendor

InitializationAccess

Display load on CAN bus
Store CAN database information
Specify function to run

Specify number of messages
available before function is
triggered

Determine status of CAN channel

Specify if channel is active or
silent

Display name of CAN transceiver

Display state or mode of CAN
transceiver

Enter custom data

Display CAN channel device type

Display NI CAN channel device
type

Display CAN device channel
index

Display CAN device serial
number

Display device vendor name

Determine control of device
channel



canChannel

Examples

See Also

Bit Timing Properties

BusSpeed
NumOfSamples

SJW
TSEG1

TSEG2

Display speed of CAN bus

Display number of samples
available to channel

Display synchronization jump
width (SJW) of bit time segment

Display amount that channel can
lengthen sample time

Display amount that channel can
shorten sample time

canch = canChannel('Vector', 'CANCaseXL 1',1)
canch = canChannel('Vector', 'Virtual 1',2)

canch

canChannel('NI',

'CAN1")

Notes You cannot use the same variable to create multiple channels
sequentially. Clear any channel in use before using the same variable
to construct a new CAN channel.

You cannot create arrays of CAN channel objects. Each object you
create must exist as its own individual variable.

canHWInfo



canDatabase

Purpose Create handle to CAN database file
Syntax candb = canDatabase('dbfile.dbc')
Description candb = canDatabase('dbfile.dbc') creates a handle to the specified

database file dbfile.dbc. You can specify just a file name, a full path,
or a relative path. MATLAB looks for dbfile.dbc on the MATLAB
path. Vehicle Network Toolbox supports the Vector CAN database
(.dbc) files.

Input dbfile.dbc

Arguments Database file name. You can specify just the name or the full path of
the database file.

Properties Messages Store message names from CAN
database
Name (Database) CAN database name
Path Display CAN database directory
path
Signals Display physical signals defined
in CAN message
UserData Enter custom data
Examples candb = canDatabase('C:\Database.dbc')
See Also canMessage



canHWInfo

Purpose
Syntax

Description

Output
Arguments

Examples

See Also

Information on available CAN devices

out canHWInfo()

out canHWInfo() returns information about CAN devices and
displays the information on a per vendor and channel basis. Use get on
the output of canHWInfo to obtain more detailed results.

out

Handle that will hold the results of canHWInfo.

info = canHWInfo;
get(info)
ToolboxName: 'Vehicle Network Toolbox'
ToolboxVersion: '1.3 (R2010b)'
MATLABVersion: '7.11 (R2010b)'
VendorInfo: [1x2 can.VendorInfo]

canChannel

6-7



canMessage

Purpose Build CAN message based on user-specified structure

Syntax message = canMessage(id, extended, datalength)
message = canMessage(database, messagename)

Descripl‘ion message = canMessage(id, extended, datalength) creates and
returns a CAN message object, from the raw message information.

message = canMessage(database, messagename) constructs a
message using the message definition of the specified message, in the
specified database.

Input id

Arguments The ID of the message that you specify.

extended

Indicates whether the message ID is of standard or extended type. The
Boolean value is true if extended or false if standard.

datalength

The length of the data of the message, in bytes. Specify from 0 through
8.

database

Handle to the CAN database containing the message definition.

messagename

The name of the message definition in the database.

Output message

Arguments The message object returned from the function.
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Properties

Examples

See Also

Data Set CAN message data

Database Store CAN database information

Error CAN message error frame

Extended Identifier type for CAN message

1D Identifier for CAN message

Name (Message) CAN message name

Remote Specify CAN message remote
frame

Signals Display physical signals defined
in CAN message

Timestamp Display message received
timestamp

UserData Enter custom data

To construct a CAN message, type:
message = canMessage (2500, true, 4)

To construct a message using CAN database message definitions, create
a database object using the canDatabase function, and then construct
your message:

candb = ('c:\database.dbc')
message = canMessage (candb, 'messagename')

attachDatabase | canDatabase | extractAll | extractRecent |
extractTime | pack | unpack
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Purpose Import CAN message log file from a third-party vendor tool
Syntax message = canMessagelImport('file', 'vendor')

message = canMessagelImport('file', 'vendor', database)
Descripl‘ion message = canMessageImport('file', 'vendor') allows you to

import a CAN message log file, file, from a third-party vendor, vendor,
into Vehicle Network Toolbox. All the messages in the log file are
imported as CAN messages, compatible with MATLAB and displayed
as an array.

message = canMessageImport('file', 'vendor', database) allows
you to apply a specify a database handle, database. The information in
the specified database is applied to the imported CAN log messages.

Once imported, you can analyze, transmit, or replay these messages.
Tips ® You can import message logs only in certain file formats. You can
import only ASCII files from Vector and text files from Kvaser.

® canMessagelImport assumes that the information in the imported log
file is in a hexadecimal format.

® canMessageImport assumes that the timestamps in the imported log
file are absolute values.

® To import Vector log files with symbolic message names, specify an
appropriate database file in the input arguments.

Input file

Arguments Name of the CAN message log file to import.

vendor

Name of the vendor whose CAN message log file to import.

database
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Output
Arguments

Examples

See Also

Name of the database whose information to attach to the imported log
file.

message

The message object returned by the function.

To import a log file, type:

message = canMessageImport('MsgLog.asc', 'Vector')

To specify a database name, type:

database = canDatabase('myDatabase.dbc')

message = canMessageImport('MsgLog.txt', 'Kvaser', database)

canDatabase | receive | transmit
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Purpose Generate technical support log
Syntax canSupport()
Descripl‘ion canSupport () returns diagnostic information for all installed CAN

devices and saves output to the text file cansupport.txt in the current
working directory.

For online support of Vehicle Network Toolbox software, visit the
toolbox page on the MathWorks Web site.
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canTool

Purpose Open CAN Tool
Syntax canTool
Description canTool starts the CAN Tool, which displays live CAN message traffic.

Use the CAN Tool to view message traffic using a selected CAN device
and channel. You can also save messages to a log file via this tool.

For more information about this tool, refer to Chapter 3, “Monitoring
CAN Message Traffic”.
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Purpose Set bit timing rate of CAN channel
Syntax configBusSpeed(canch, busspeed)
configBusSpeed(canch, busspeed, sjw, tsegl, tseg2,
numberofsamples)
Descripl‘ion configBusSpeed(canch, busspeed) sets the speed of the CAN channel

in a direct form that uses baseline bit timing calculation factors.

configBusSpeed(canch, busspeed, sjw, tsegl, tseg2,
numberofsamples) sets the speed of the CAN channel canch to
busspeed using the specified bit timing calculation factors to control
the timing in an advanced form.

Tips ® Unless you have specific timing requirements for your CAN
connection, use the direct form of configBusSpeed. Also note that
you can set the bus speed only when the CAN channel is offline. The
channel must also have initialization access to the CAN device.

® Synchronize all nodes on the network for CAN to work successfully.
However, over time, clocks on different nodes will get out of sync,
and must resynchronize. SUW specifies the maximum width (in time)
that you can add to tseg1 (in a slower transmitter), or subtract from
tseg2 (in a faster transmitter) to regain synchronization during the
receipt of a CAN message.

Input canch

Arguments The CAN channel object that you want to set the bit timing rate for.

busspeed

The user-specified bit timing rate for the specified object.

Sjw
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|

The synchronization jump width. This value is the maximum value of
time bit adjustments.

tsegl
The length of time at the start of the sample point within a bit time.

tseg2
The length of time at the end of the sample point within a bit time.

numberofsamples
The specified count of bit samples used.
Examples To configure the bus speed using baseline bit timing calculation, type:

canch = canChannel('Vector', 'CANCaseXL 1',1)
configBusSpeed(canch,250000)

To specify the bit timing calculations, type:

canch = canChannel('Kvaser', 'USBcan Professional 1', 1)
configBusSpeed(channel, 500000, 1, 4, 3, 1)

See Also canChannel
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Purpose
Syntax

Description

Input
Arguments

Examples

See Also

Discard all messages from CAN channel
discard(canch)

discard(canch) discards messages that are available to receive on
the channel, canch.

canch

CAN channel that you want to discard the messages from.

Set up a CAN channel to receive messages and discard the messages
received by the channel.

Create a CAN channel to receive messages and start the channel:

rxCh = canChannel('Vector', 'CANcaseXL 1',1);
start (rxCh)

Discard all messages in this channel:

discard(rxCh);

canChannel



extractAll

Purpose

Syntax

Description

Tips

Input
Arguments

Select all instances of message from array of messages

[extracted, remainder] = extractAll(message, messagename)
[extracted, remainder] extractAll (message, id, extended)

[extracted, remainder] extractAll (message, messagename)
parses the given array message, and returns all instances of messages
matching the specified message name.

[extracted, remainder] = extractAll(message, id, extended)
parses the given array message, and returns all instances of messages
matching the specified ID with the specified standard or extended type.

You can specify id as a cell array of message names or a vector of
identifiers. For example, if you pass id in as [250 5000], [false true],
extractAll returns every instance of both CAN message 250 and
message 5000 that it finds in the message array. If any id in the vector
1s an extended type, set extended to true and as a vector of the same
length as id.

message

An array of CAN message objects that you specify to parse and find the
specified messages by name or ID.

messagename

The name of the message that you specify to extract.
id

The ID of the message that you specify to extract.

extended

Indicates whether the message ID is a standard or extended type. The
Boolean value is true if extended and false if standard.
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Output
Arguments

Examples

See Also

extracted

An array of CAN message objects returned with all instances of id
found in the message.

remainder

A CAN message object containing all messages in the original input
message with all instances of id removed.

[msgOut, remainder]=extractAll(message, 'msgl')
[msgOut, remander]=extractAll(message,{'msgl' 'msg2' 'msg3'})
[msgOut, remainder]=extractAll(message, 3000, true)

[msgOut, remainder]=extractAll(message,[200 5000],[false true])

extractRecent | extractTime



extractRecent

Purpose

Syntax

Description

Tips

Input
Arguments

Select most recent message from array of messages

extracted = extractRecent(message)
extracted extractRecent (message, messagename)
extracted extractRecent (message, id, extended)

extracted = extractRecent(message) parses the given array
message and returns the most recent instance of each unique CAN
message found in the array.

extracted = extractRecent(message, messagename) parses the
specified array of messages and returns the most recent instance
matching the specified message name.

extracted = extractRecent(message, id, extended) parses the
given array message and returns the most recent instance of the
message matching the specified ID with the specified standard or
extended type.

You can specify id as a vector of identifiers. For example, if you pass
id in as [250 500], extractRecent returns the latest instance of both
CAN message 250 and message 500 if it finds them in the message
array. By default, all identifiers in the vector are standard CAN
message 1dentifiers unless extended is true. If any id in the vector is
an extended type, then extended i1s true and is a vector of the same
length as id.

message

An array of CAN message objects that you specify to parse and find the
specified messages by name or ID.

messagename

The name of the message that you specify to extract.

id

The id of the message that you specify to extract.
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extended

Indicates whether the message ID is a standard or extended type. The
Boolean value is true if extended and false if standard.

OUi‘pUi‘ extracted

Arguments An array of CAN message objects returned with the most recent

instance of id found in the message.

Examples msgOut = extractRecent(message)

msgOut = extractRecent(message, 'msgl')

msgOut = extractRecent

(
(
msgOut = extractRecent(message, {'msgl' 'msg2' msg3'})
(message, 3000, true)
(

msgOut = extractRecent(message, [400, 5000], [false true])

See Also extractAll | extractTime
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Purpose
Syntax

Description

Tips

Input
Arguments

Output
Arguments

Select messages occurring within specified time range from array of
messages

extracted = extractTime(message, starttime, endtime,
msgRange)

extracted = extractTime(message, starttime, endtime,
msgRange) parses the array message and returns all messages with a
timestamp within the specified starttime and endtime, including the
starttime and endtime

Specify the time range in increasing order from starttime to endtime.
If you must specify the largest available time, endtime also accepts
Inf as a valid value. The earliest acceptable time you can specify for
starttime is 0.

message

An array of CAN message objects.

starttime

The beginning of the time range in seconds that you specify. Returns
messages with a timestamp greater than or equal to the specified start
time.

endtime

The end of the time range in seconds that you specify. Parses messages
with a timestamp up to the specified end time, including the specified
end time.

extracted

An array of CAN message objects returned with all messages that occur
within and including starttime and endtime.
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Examples

See Also

msgRange
msgRange =
msgRange =

extractAll

extractTime (message,
extractTime (message,
extractTime (message,

| extractRecent

5, 10.5)
0, 60)
150, Inf)



filterAllowAll

Purpose
Syntax

Description

Input
Arguments

Examples

See Also

Allow all messages of specified identifier type
filterAllowAll(canch, 'type')

filterAllowAll(canch, 'type') opens the filter on the specified CAN
channel to allow all messages matching the specified identifier type to
pass the acceptance filter.

canch

The CAN channel on which you want to filter messages.

type
The identifier type by which to filter. CAN messages are 'Standard'
and 'Extended'.

To allow all standard and extended message typed to pass the filter,
type:

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterAllowAll(canch, 'Standard')
filterAllowAll(canch, 'Extended')

filterAllowOnly | filterBlockAll
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Purpose

Syntax

Description

Tips

Input
Arguments

Configure message filter to allow only specified messages

filterAllowOnly(canch, 'name')
filterAllowOnly(canch, ids, 'type')

filterAllowOnly(canch, 'name') configures the filter on the channel
canch, to pass only messages with the specified name.

filterAllowOnly(canch, ids, 'type') configures the filter on the
channel canch, to pass only messages of the specified type with the
specified identifier.

e Use Database to attach a database to your CAN channel and filter
messages using message names.

® The id value is stored as a decimal value. To convert a hexadecimal
to a decimal value, use the hex2dec function.

canch

The CAN channel on which you want to filter messages.

name

the name of the CAN message that you want to allow. You can specify a
single name as a string or a cell array of message names.

ids

The CAN message ID or IDs that you want to allow. You can specify:

¢ Single value, such as 600

e Multiple values, such as [600,610]

e Range of values, such as [600:800]

e Multiple ranges, such as [200:400, 600:800]

type



filterAllowOnly

Examples

See Also

The identifier type by which to filter messages. CAN messages are
'Standard' and 'Extended'’

To filter a database defined message with name 'EngineMsg’, type:

canch = canChannel('Vector', 'CANCaseXL 1',1);
canch.Database = canDatabase('candatabase.dbc');
filterAllowOnly(canch, 'EngineMsg"')

To filter messages by identifier, type:

canch = canChannel('Vector', 'CANCaseXL 1',1);
filterAllowOnly(canch,[602 612], 'Standard');

filterAllowAll | filterBlockAll | hex2dec
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Purpose Configure filter to block messages with specified identifier type

Syntax filterBlockAll (canch, 'type')

Description filterBlockAll(canch, 'type') configures the message filter to block
all messages matching the specified identifier type.

Input canch

Arguments The CAN channel on which you want to filter messages.

type

The identifier type by which to filter messages. CAN messages are
'Standard' and 'Extended’.

Examples To block all standard message types, type:

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterBlockAll(canch, 'Standard')

See Also filterAllowAll | filterAllowOnly
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Purpose

Syntax

Description

Set range of CAN 1identifiers to pass acceptance filter

Note filterAcceptRange will be removed in a future version. Use
filterAllowAll, filterAllowOnly, or filterBlockAll instead.

filterAcceptRange(canch, rangestart, rangeend)

Note You cannot set filters on an NI device channel.

filterAcceptRange(canch, rangestart, rangeend) sets the
acceptance filter for standard identifier CAN messages. It allows
messages within the given range on the CAN channel canch to pass.
rangestart and rangeend establish the beginning and end of the
acceptable range. You can use this function with Vector devices only.

Notes

® You can configure message filtering only when the CAN channel is
offline.

® CAN message filters initialize to fully open.

e filterReset makes the acceptance filters fully open.

e filterAcceptRange supports only standard (11-bit) CAN identifiers.

® You must set the values from rangestart through rangeend in
increasing order.

e filterAcceptRange and filterBlockRange work together by
allowing and blocking ranges of CAN messages within a single filter.
You can perform both operations multiple times in sequence to
custom configure the filter as desired.
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Tips

Input
Arguments

Examples

See Also

When you call filterAcceptRange on an open or reset filter, it
automatically blocks the entire standard CAN identifier range, allowing
only the desired range to pass. Subsequent calls to filterAcceptRange
open additional ranges on the filter without blocking the ranges
previously allowed.

canch

The CAN channel that you want to set the filter for.

rangestart

The first identifier of the range of message IDs that the filter accepts.

rangeend
The last identifier of the range of message IDs that the filter accepts.
canch = canChannel('Vector', 'CANCaseXL 1',1)

filterAcceptRange(canch,600,625)
filterAcceptRange(canch,705,710)

filterBlockRange | filterReset | filterSet



filterBlockRange

Purpose

Syntax

Description

Tips

Input
Arguments

Set range of CAN identifiers to block via acceptance filter

Note filterBlockRange will be removed in a future version. Use
filterAllowAll, filterAllowOnly, or filterBlockAll instead.

filterBlockRange(canch, rangestart, rangeend)

Note You cannot set filters on an NI device channel.

filterBlockRange(canch, rangestart, rangeend) blocks messages
within a given range by setting an acceptance filter. You can use this
function with Vector devices only.

® You can configure message filtering only when the CAN channel is
offline.

® CAN message filters initialize to fully open.

e filterReset makes the acceptance filters fully open.

e filterBlockRange supports only standard (11-bit) CAN identifiers.

®* You must set the values from rangestart through rangeend in
increasing order.

e filterBlockRange and filterAcceptRange work together by
blocking and allowing ranges of CAN messages within a single filter.
You can perform both operations multiple times in sequence to
custom configure the filter as desired.

canch

The CAN channel that you want to set the filter for.

rangestart
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Examples

See Also

The first identifier of the range of message IDs that the filter starts
blocking at.

rangeend

The last 1dentifier of the range of message IDs that the filter stops
blocking at.

You can set the filter to block or accept messages within a specific range.

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterBlockRange(canch, 500, 750)
filterAcceptRange(canch,600,625)
filterAcceptRange(canch,705,710)
filterBlockRange(canch,1075,1080)

filterAcceptRange | filterReset | filterSet



filterReset

Purpose

Syntax

Description

Input
Arguments

Examples

See Also

Open CAN message acceptance filters

Note filterReset will be removed in a future version. Use
filterAllowAll, filterAllowOnly, or filterBlockAll instead.

filterReset(canch)

Note You cannot set filters on an NI device channel.

filterReset(canch) resets the CAN message filters on the CAN
channel canch for both standard and extended CAN identifier types.
Then all messages of all identifier types can pass.

This function does not work if the channel is online. Make sure that the
channel is offline before calling filterReset.

canch

The CAN channel that you want to reset the filter for.

Reset the message filters as shown:

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterBlockRange(canch, 500, 750)
filterAcceptRange(canch,600,625)
filterAcceptRange(canch,705,710)
filterBlockRange(canch,1075,1080)
filterSet(canch, 500, 750, 'Standard')
filterReset(canch)

filterAcceptRange | filterBlockRange | filterSet

6-31



filterSet

Purpose

Syntax

Description

Tips

Input
Arguments

6-32

Set specific CAN message acceptance filter configuration

Note filterSet will be removed in a future version. Use
filterAllowAll, filterAllowOnly, or filterBlockAll instead.

filterSet(canch, code, mask, idtype)
filterSet(canch, id, idtype)

Note You cannot set filters on an NI device channel.

filterSet(canch, code, mask, idtype) sets the CAN message
acceptance filter to the specified code and mask. You also must specify
the CAN identifier type idtype on the CAN channel canch.

filterSet(canch, id, idtype) sets the CAN message acceptance
filter by determining the best possible code and mask based on the ID
and identifier type specified in the input argument.

® You can configure message filtering only when the CAN channel is
offline.

CAN message filters initialize to fully open.

Use filterReset to make the acceptance filters fully open.

e filterSet supports either standard or extended CAN identifiers.

canch

The CAN channel that you want to set the filter for.

code

The value required for each bit position of the identifier.



filterSet

Examples

See Also

mask

The bits in the identifier that are relevant to the filter.

id

Set a filter on the CAN message with the id, range of ids, multiple
ranges of ids, or a combination of ids.

idtype

A string specifying either a standard or an extended CAN message

id type.

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterSet(canch,500,750, 'Standard')
filterSet(canch,2500,3000, 'Extended')

To let Vehicle Network Toolbox determine the best possible code and
mask option:

canch = canChannel('Kvaser', 'USBcan Professional 1', 1)
filterSet(canch, [500:502 1000], 'Standard')
filterSet(canch, [7500:8000 12000], 'Extended')

filterAcceptRange | filterBlockRange | filterReset
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Purpose
Syntax

Description

Examples

Return property values

out get (obj)

out = get (obj) returns the structure out, where each field name is
the name of a property of the specified object and each field contains
the value of that property.

Configure a CAN channel:

canch = canChannel('Vector', 'CANCaseXL 1',1)

Call get on the CAN channel object to obtain the properties of the
configured CAN channel:

get (canch)

Configure a CAN message:

message = canMessage (250, true, 8)

Call get on the message object to obtain the properties of the configured
message:

get (message)
Configure a CAN database:

candb = canDatabase('C:\Database.dbc')

call get on the database to obtain the properties of the configured
database:

get (candb)



messagelnfo

Purpose

Syntax

Description

Input
Arguments

Output
Arguments

Examples

Information about CAN messages

msgInfo = messagelInfo(candb)
msgInfo messageInfo(candb, 'msgName')
msgInfo messageInfo(candb, id, extended)

msgInfo = messageInfo(candb) returns information about CAN
messages in the specified database candb.

msgInfo = messageInfo(candb, 'msgName') returns information
about the specified message 'msgName ' in the specified database candb.

msgInfo = messageInfo(candb, id, extended) returns information
about the message with the specified standard or extended ID in the
specified database candb.

candb

The database containing the CAN messages that you want information
about.

msgName

The name of the message you want information about.
id

The numeric identifier of the specified message.

extended

Indicates whether the message ID is in standard or extended type. The
Boolean value is true if extended and false if standard.

msgInfo

Handle for the returned CAN messages in the specified database.

candb = canDatabase('c:\Database.dbc')
msgInfo = messageInfo(candb)
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msgInfo = messagelInfo(candb, 'msgName')
msgInfo = messagelInfo(candb, 500, false)

See Also canDatabase | canMessage | signallnfo
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Purpose
Syntax

Description

Input
Arguments

Examples

See Also

Pack signal data into CAN message
pack (message, value, startbit, signalsize, byteorder)

pack(message, value, startbit, signalsize, byteorder) takes
specified input parameters and packs them into the message.

message

The CAN message structure that you specify for the signal to be packed
n.

value

The value of the signal you specify to be packed in the message.

startbit

The signal’s starting bit in the data. This is the least significant bit
position in the signal data. Accepted values for startbit are from 0
through 63.

signalsize

The length of the signal in bits. Accepted values for signalsize are
from 1 through 64.

byteorder

The signal byte order format. Accepted values are 'LittleEndian'
and 'BigEndian'.

pack (message, 25, 0, 16, 'LittleEndian')

canMessage | extractAll | extractRecent | extractTime | unpack
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Purpose Receive messages from CAN bus
Syntax message = receive(canch, messagesrequested)
Descripl‘ion message = receive(canch, messagesrequested) returns an array of

CAN message objects received on the CAN channel canch. The number
of messages returned is less than or equal to messagesrequested. If
fewer messages are available than messagesrequested specifies, the
function returns the currently available messages. If no messages are
available, the function returns an empty array. If messagesrequested
is infinite, the function returns all available messages.

To understand the elements of a message, refer to canMessage.

Input canch

Arguments The CAN channel from which to receive the message.

messagesrequested

The maximum count of messages to receive. The specified value must
be a nonzero and positive, or Inf.

Output message
Arguments An array of CAN message objects received from the channel.
Properties Receive Message Properties
MessageReceivedFcn Specify function to run
MessageReceivedFcnCount Specify number of messages
available before function is
triggered
MessagesAvailable Display number of messages
available to be received by CAN
channel
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Examples

See Also

MessagesReceived Display number of messages
received by CAN channel
MessagesTransmitted Display number of messages

transmitted by CAN channel

Error Log Properties

ReceiveErrorCount Display number of received errors
detected by channel

TransmitErrorCount Display number of transmitted
errors by channel

canch = canChannel('Vector', 'CANCaseXL 1',1)
start(canch)
message = receive(canch,5)

To receive all messages, type:

message = receive(canch,Inf)

canChannel | canMessage | transmit
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Purpose

Syntax

Arguments

Description

Input
Arguments

Examples

Retransmit messages from CAN bus

replay(canch, message)

replay(canch, message) retransmits the message or messages
message on the channel canch, based on the relative differences of their
timestamps. The replay function also replays messages from MATLAB
to Simulink

To understand the elements of a message, refer to canMessage.

canch

The CAN channel that you specify to transmit the messages.

message

An array of message objects to replay.

This example uses a loopback connection between two channels where:
¢ The first channel transmits messages 2 seconds apart.
® The second channel receives them.

¢ The replay function retransmits the messages with the original
delay.

ch1 = canChannel('Vector', 'CANcaseXL 1', 1)

ch2 = canChannel('Vector', 'CANcaseXL 1', 2)

start(ch1)

start(ch2)

msgTx1 = canMessage (500, false, 8)

msgTx2 = canMessage (750, false, 8)

%The first channel transmits messages 2 seconds apart



replay

See Also

transmit(cht1, msgTx1)

pause(2)

transmit(ch1, msgTx2)

%The second channel receives them

msgRx1 = receive(ch2, Inf)

%The replay function retransmits the messages with the original delay.
replay(ch2, msgRx1)

pause(2)

msgRx2 = receive(ch1, Inf)

The timestamp differentials between messages in the two receive
arrays, msgRx1 and msgRx2, are equal.

canChannel | canMessage | receive | transmit
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Purpose Configure property values

Syntax set (obj, propertyname, propertyvalue)

Descripl‘ion set (obj, propertyname, propertyvalue) configures the specified
property, propertyname, on the object obj, to the value specified in
propertyvalue.

Examples To set a CAN channel property:
canch = canChannel('Vector', 'CANcaseXL 1', 1)

set (canch, 'SilentMode', true)

To set a CAN message property:

message = canMessage (250, 8, true)
set (message, 'Remote', true)

To set a CAN message signal property:

candb = canDatabase('C:\Database.dbc')
message = canMessage(candb, 'Battery_Voltage')
set (message, 'BatVlt', 9.3)
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Purpose

Syntax

Description

Input
Arguments

Information about signals in CAN message

SigInfo = signalInfo(candb, 'msgName')
SigInfo = signallInfo(candb, id, extended)
SigInfo = signallInfo(candb, id, extended, 'signalName')

SigInfo = signalInfo(candb, 'msgName') returns information about
the signals in the specified CAN message msgName, in the specified
database candb.

SigInfo = signalInfo(candb, id, extended) returns information
about the signals in the message with the specified standard or
extended ID id, in the specified database candb.

SigInfo = signalInfo(candb, id, extended, 'signalName')
returns information about the specified signal 'signalName' in the
message with the specified standard or extended ID id, in the specified
database candb.

candb

The database containing the signals that you want information about.

msgName

The name of the message that contains the signals that you want
information about.

id

The numeric identifier of the specified message that contains the
signals you want information about.

extended

Indicates whether the message ID is in standard or extended type. The
Boolean value is true if extended and false if standard.

signalName
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Output
Arguments

Examples

See Also

The name of the specific signal that you want information about.

SigInfo

The signal information object returned from the function.
SigInfo=signalInfo(candb, 'Battery_Voltage')
SigInfo=signalInfo(candb, 'Battery_Voltage', 196608, true)

SigInfo=signalInfo
(candb, 'Battery_Voltage', 196608, true, 'BatVlt')

canDatabase | canMessage | messageInfo



start

Purpose
Syntax

Description

Examples

See Also

Set CAN channel online
start(canch)

start(canch) starts the CAN channel canch on the CAN bus to send
and receive messages. The CAN channel remains online unless:

® You call stop on this channel.

¢ The channel clears from the workspace.

canch = canChannel('Vector', 'CANCaseXL 1',1)
start(canch)

stop
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Purpose
Syntax

Description

Examples

See Also

Set CAN channel offline
stop(canch)

stop(canch) stops the CAN channel canch on the CAN bus. The CAN
channel also stops running when you clear canch from the workspace.

canch = canChannel('Vector', 'CANCaseXL 1',1)

start(canch)
stop(canch)

start



transmit

Purpose
Syntax

Description

Tips

Input
Arguments

Examples

Send CAN messages to CAN bus
transmit(canch, message)
transmit(canch, message) sends the array of messages onto the bus

via the CAN channel.

To understand the elements of a message, refer to canMessage.

The Transmit function ignores the Timestamp property and the Error
property.
canch

The CAN channel that you specify to transmit the message.

message

The message or an array of messages that you specify to transmit via
a CAN channel.

message = canMessage (250, false, 8)
message.Data = ([45 213 53 1 3 213 123 43])
canch = canChannel('Vector', 'CANCaseXL 1', 1)
start(canch)

transmit(canch, message)

To transmit an array, construct messagel and message?2 as in this
example, and type:

transmit(canch, [message, messagel message2?])

To transmit messages on a remote frame, type:

message = canMessage (250, false 8, true)
message.Data = ([45 213 53 1 3 213 123 43])
message.Remote = true

canch = canChannel('Vector', 'CANCaseXL 1', 1)
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start(canch)
transmit(canch, message)

See Also canChannel | canMessage | receive
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Purpose
Syntax

Description

Input
Arguments

Examples

Display messages configured for automatic transmit
transmitConfiguration(canch)

transmitConfiguration(canch) displays information about all
messages in the CAN Channel, canch, configured for periodic transmit
or event-based transmit.

For more information on periodic transmit of messages, refer to
transmitPeriodic.

For more information on event-based transmit of messages, refer to
transmitEvent.

canch

Name of the CAN channel configured for periodic transmit or
event-based transmit.

Create a CAN channel and configure two messages:

canch = canChannel('Vector', 'Virtual 1', 1);
msg1 = canMessage (500, false, 8);
msg2 = canMessage(750, false, 8);

Transmit msgl and msg2 using transmitEvent and transmitPeriodic
respectively:

transmitEvent(canch, msgi, 'On');
transmitPeriodic(canch, msg2, 'On', 1);

Display messages on canch configured for periodic or event-based
transmit:

transmitConfiguration(canch)

The function returns information about periodic configuration:

Periodic Messages
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See Also

ID Extended Name Data Rate (seconds)

750 false 0000O0O0OO 1.000000

Event Messages
ID Extended Name Data

500 false 0o000O0OO0CO0CO

canChannel | canMessage | transmitEvent | transmitPeriodic



transmitEvent

Purpose
Syntax

Description

Input
Arguments

Examples

See Also

Configure a message for event-based transmit
transmitEvent(canch, msg, 'state')

transmitEvent(canch, msg, 'state') enables an event-based
transmit of the CAN message, msg, on the channel, canch when ’state’
1s On and disables it when 'state' is Off.

canch

The name of the CAN channel on which the specified message is
enabled for event-based transmit.

msg

The message enabled for event-based transmission on the specified
CAN channel.

'state’

Specify whether event-based transmission is enabled on the specified
message. Input Off to enable event-based transmission on the specified
message, and Off for disabling it.

Construct a CAN channel and configure a message on the channel:

canch = canChannel('Vector', 'CANCaseXL 1', 1);
msg = canMessage (500, false, 4);

Enable the message for event-based transmit, start the channel, and
change some data to trigger the event-based transmit:

transmitEvent(ch, msg, 'On');
start(canch);
msg.Data = [1 2 3 4];

canChannel | canMessage | transmitConfiguration
transmitPeriodic
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Purpose

Syntax

Description

Tips

Input
Arguments

Configure a message for periodic transmit

transmitPeriodic(canch, msg, 'On', period)
transmitPeriodic(canch, msg, 'Off')

transmitPeriodic(canch, msg, 'On', period) enables periodic
transmit of the message, msg, on the channel, canch, to transmit at the
specified period, period.

transmitPeriodic(canch, msg, 'Off') disables periodic transmit of
the message, msg, on the channel, canch.

You can enable and disable periodic transmit even when the channel
is running. This functionality allows you to make changes to the state
of the channel without stopping the channel.

canch

The name of the CAN channel on which the specified message is
enabled for periodic transmit.

msg

The message enabled for periodic transmission on the specified CAN
channel.

‘state’

Specify whether periodic transmission is enabled on the specified
message. Input On for enabling periodic transmission on the specified
message and Off to disable it. If you enable periodic transmission,
specify a period value.

period

Specify a period in seconds. This value is used to transmit the message
in the specified period. By default this value is 0.500 seconds.



transmitPeriodic

Examples

See Also

Construct a CAN channel and configure a message on the channel:

canch = canChannel('Vector', 'Virtual 1', 1);
msg = canMessage (500, false, 4);

Enable the message for periodic transmit. Set the period value to 1
sec, start the channel, and update the data in the message you want
to send periodically:

transmitPeriodic(canch, msg, 'On', 1);
start(canch);
msg.Data = [1 2 3 4];

canChannel | canMessage | transmitConfiguration | transmitEvent
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Purpose

Syntax

Description

Input
Arguments

Output
Arguments

Examples

Unpack signal data from message

value = unpack(message, startbit, signalsize, byteorder,
datatype)

value = unpack(message, startbit, signalsize, byteorder,
datatype) takes a set of input parameters to unpack the signal value
from the message and returns the value as output.

message
The CAN message structure that you specify for the signal to be
unpacked from.

startbit

The signal’s starting bit in the data. This is the least significant bit
position in the signal data. Accepted values for starbit are from 0
through 63.

signalsize

The length of the signal in bits. Accepted values for signalsize are
from 1 through 64.

byteorder

The signal binary or binblock format. Accepted values are LittleEndian
and BigEndian

datatype

The data type that you want to get the unpacked value in.

value

The value of the message that you specify to be unpacked.

value = unpack(message, 0, 16, 'LittlegEndian', 'int16')



unpack

See Also canMessage | extractAll | extractRecent | extractTime | pack
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Property Reference

CAN Channel Base Properties Apply to CAN channels on all devices
(p. 7-2)

Device-Specific Properties (p. 7-5) Apply to CAN channels on specific
devices



7 Property Reference

CAN Channel Base Properties

Channel Status Properties (p. 7-2)

CAN Message Properties (p. 7-2)

CAN Database Properties (p. 7-3)

Receiving Messages (p. 7-3)

Error Logging (p. 7-4)

Channel Status Properties

BusLoad

BusStatus

Database
InitializationAccess
Running

SilentMode

UserData

CAN Message Properties

Data
Database
Error
Extended
ID

Setting properties that specify
different status of CAN channel

Setting properties that specify CAN
message properties

Setting properties of CAN channels
attached to CAN database

Defining actions based on available
messages on CAN channel

Properties for receiving and
transmitting error messages

Display load on CAN bus
Determine status of CAN bus

Store CAN database information
Determine control of device channel
Determine status of CAN channel
Specify if channel is active or silent

Enter custom data

Set CAN message data

Store CAN database information
CAN message error frame
Identifier type for CAN message
Identifier for CAN message



CAN Channel Base Properties

Name (Message)
Remote

Signals

Timestamp

UserData

CAN Database Properties

Messages

Name (Database)
Path

Signals

UserData

Receiving Messages

MessageReceivedFcn

MessageReceivedFcnCount

MessagesAvailable

MessagesReceived

MessagesTransmitted

CAN message name
Specify CAN message remote frame

Display physical signals defined in
CAN message

Display message received timestamp

Enter custom data

Store message names from CAN
database

CAN database name

Display CAN database directory
path

Display physical signals defined in
CAN message

Enter custom data

Specify function to run

Specify number of messages
available before function is triggered

Display number of messages
available to be received by CAN
channel

Display number of messages received
by CAN channel

Display number of messages
transmitted by CAN channel



7 Property Reference

7-4

Error Logging

ReceiveErrorCount

TransmitErrorCount

Display number of received errors
detected by channel

Display number of transmitted
errors by channel



Device-Specific Properties

Device-Specific Properties

Device Settings (p. 7-5)
Transceiver Settings (p. 7-5)

Bit Timing Settings (p. 7-5)

Device Settings

Device

Device (NI)
DeviceChannelIndex
DeviceSerialNumber

DeviceVendor

Transceiver Settings

TransceiverName

TransceiverState

Bit Timing Settings

BusSpeed
NumOfSamples

SJW

Properties displaying vendor-specific
device information

Properties displaying CAN channel
transceiver information

Properties defining the bit timing
and segmentation

Display CAN channel device type
Display NI CAN channel device type
Display CAN device channel index
Display CAN device serial number

Display device vendor name

Display name of CAN transceiver

Display state or mode of CAN
transceiver

Display speed of CAN bus

Display number of samples available
to channel

Display synchronization jump width
(SJW) of bit time segment
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TSEG1

TSEG2

Display amount that channel can
lengthen sample time

Display amount that channel can
shorten sample time
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BusLoad property

Purpose

Description

Characteristics

Values

See Also

Display load on CAN bus

The BusLoad property displays information about the load on the CAN
network for message traffic on Kvaser devices.

Usage CAN channel
Read only Always
Data type Float

The current message traffic on a CAN network is represented as a
percentage ranging from 0.00% to 100.00%.

Functions

canChannel



BusSpeed property

Purpose

Description

Characteristics

Values

Examples

See Also

Display speed of CAN bus

The BusSpeed property determines the bit rate at which messages are
transmitted. You can set BusSpeed to an acceptable bit rate using the
configBusSpeed function.

Usage CAN channel
Read only Always
Data type Numerical

The default value is assigned by the vendor driver. To change the bus
speed of your channel, use the configBusSpeed function and pass the
channel name and the value as input parameters.

To change the current BusSpeed of the CAN channel object canch to
250000, type:

configBusSpeed(canch, 250000)
Functions
canChannel, configBusSpeed

Properties
NumOfSamples, SUW, TSEG1, TSEG2



BusStatus property

Purpose Determine status of CAN bus
Description The BusStatus property displays information about the state of the
CAN bus.
Characteristics ygage CAN channel
Read only Always
Data type String
Values e N/A
® BusOff
® ErrorOff

® ErrorActive

See Also Functions

canChannel
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Data property

Purpose

Description

Characteristics

Values

Examples

See Also

Set CAN message data

Use the Data property to define your message data in a CAN message.

Usage CAN message
Read only Never
Data type Numeric

The data value is a uint8 array, based on the data length you specify
in the message.

To load data into a message, type:

message.Data = [23 43 23 43 54 34 123 1]

If you are using a CAN database for your message definitions, change
values of the specific signals in the message directly.

You can also use the pack function to load data into your message.

Functions

canMessage, pack



Database property

Purpose

Description

Characteristics

Values

Examples

Store CAN database information

The Database property stores information about an attached CAN
database.

Usage CAN channel, CAN message
Read only For a CAN message property
Data type Database handle

This property displays the database information that your CAN channel
or CAN message is attached to. This property displays an empty
structure, [ ], if your channel message is not attached to a database.
You can edit the CAN channel property, Database, but cannot edit

the CAN message property.

To see information about the database attached to your CAN message,
type:

message.Database

To set the database information on your CAN channel to
C:\Database.dbc, type:

channel.Database = canDatabase('C:\Database.dbc')

Tip CAN database file names containing non-alphanumeric characters
such as equal signs, ampersands, and so forth are incompatible with
Vehicle Network Toolbox. You can use a period sign in your database
name. Rename any CAN database files with non-alphanumeric
characters before you use them.




Database property
|

See Also Functions

attachDatabase, canChannel, canDatabase, canMessage



Device property

Purpose

Description

Characteristics

Values

See Also

Display CAN channel device type
For National Instruments devices, the Device property displays the
device number on the hardware.

For all other devices, the Device property displays information about
the device type to which the CAN channel is connected.

Usage CAN channel
Read only Always
Data type String

Values are automatically defined when you configure the channel with
the canChannel function.

Functions

canChannel, canHWInfo

Properties

DeviceChannelIndex, DeviceType, DeviceVendor



Device(NI) property

Purpose

Description

Characteristics

Values

See Also

Display NI CAN channel device type

For National Instruments devices, the DeviceType property displays
information about the device type to which the CAN channel is
connected.

Usage CAN channel
Read only Always
Data type String

Values are automatically defined when you configure the channel with
the canChannel function.

Functions

canChannel, canHWInfo

Properties

DeviceChannelIndex, DeviceVendor



DeviceChannellndex property
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Purpose

Description

Characteristics

Values

See Also

Display CAN device channel index

The DeviceChannelIndex property displays the channel index on which
the selected CAN channel is configured.

Usage CAN channel
Read only Always
Data type Numeric

Values are automatically defined when you configure the channel with
the canChannel function.

Functions

canChannel, canHWInfo

Properties

Device, DeviceVendor



DeviceSerialNumber property

Purpose Display CAN device serial number
Description The DeviceSerialNumber property displays the serial number of the
CAN device.
Characteristics ygage CAN channel
Read only Always
Data type ® Numeric

¢ Hexadecimal String (NI CAN devices only)

Values Values are automatically defined when you configure the channel with
the canChannel function.

See Also Functions

canChannel, canHWInfo

Properties

Device, DeviceVendor
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DeviceVendor property

Purpose Display device vendor name
Description The DeviceVendor property displays the name of the device vendor.
Characteristics ygage CAN channel
Read only Always
Data type String
Values Values are automatically defined when you configure the channel with

the canChannel function.

See Also Functions

canChannel, canHWInfo

Properties

Device, DeviceChannelIndex, DeviceSerialNumber
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Error property

Purpose

Description

Characteristics

Values

See Also

CAN message error frame

The Error property is a read-only value that identifies the specified
CAN message as an error frame. The channel sets this property to true
when it receives a CAN message as an error frame.

Usage CAN message
Read only Always
Data type Boolean

e false — The message is not an error frame.

¢ true — The message is an error frame.

The Error property displays false, unless the message is an error
frame.

Functions

canMessage
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Extended property

Purpose

Description

Characteristics

Values

Examples

See Also

8-14

Identifier type for CAN message

The Extended property is the identifier type for a CAN message. It can
either be a standard identifier or an extended identifier.

Usage CAN message
Read only Always
Data type Boolean

¢ false — The identifier type is standard (11 bits).
¢ true — The identifier type is extended (29 bits).

To set the message identifier type to extended with the ID set to 2350
and the data length to 8 bytes, type:

message = canMessage (2350, true, 8)
You cannot edit this property after the initial configuration.

Functions

canMessage

Properties
ID



ID property

Purpose

Description

Characteristics

Values

Examples

See Also

Identifier for CAN message

The ID property represents a numeric identifier for a CAN message.

Usage CAN message
Read only Always
Data type Numeric

The ID value must be a positive integer from:

¢ 0 through 2047 for a standard identifier
¢ 0 through 536,870,911 for an extended identifier

You can also specify a hexadecimal value using the hex2dec function.

To configure a message ID to a standard identifier of value 300 and a
data length of 8 bytes, type:

message = canMessage (300, false, 8)

Functions

canMessage

Properties
Extended
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InitializationAccess property
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Purpose

Description

Characteristics

Values

See Also

Determine control of device channel

The InitializationAccess property determines if the configured CAN
channel object has full control of the device channel. You can change
some property values of the hardware channel only if the object has full
control over the hardware channel.

Note Only the first channel created on a device is granted initialization

access.
Usage CAN channel
Read only Always
Data type Boolean

® Yes — Has full control of the hardware channel and can change the
property values.

® No — Does not have full control and cannot change property values.

Functions

canChannel



MessageReceivedFcn property

Purpose

Description

Characteristics

Values

Examples

See Also

Specify function to run

Configure MessageReceivedFcn as a callback function to run a string
expression, a function handle, or a cell array when a specified number
of messages are available.

The MessageReceivedFcnCount property defines the number of
messages available before the configured MessageReceivedFcn runs.

Usage CAN channel
Read only Never
Data type Callback function

The default value is an empty string. You can specify the name of a
callback function that you want to run when the specified number of
messages are available.

canch.MessageReceivedFcn = @Myfunction
You can also use the set function to set the values of this property.

Functions

canChannel, set

Properties

MessageReceivedFcnCount, MessagesAvailable
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MessageReceivedFcnCount property

Purpose Specify number of messages available before function is triggered

Description Configure MessageReceivedFcnCount to the number of messages that
must be available before a MessageReceivedFcn is triggered.

Characteristics ygage CAN channel
Read only While channel is online
Data type Double
Values The default value is 1. You can specify a positive integer for your

MessageReceivedFcnCount.
Examples canch.MessageReceivedFcnCount = 55
You can also use the set function to set the values of this property.

See Also Functions

canChannel, set

Properties

MessageReceivedFcn, MessagesAvailable
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Messages property

Purpose

Description

Characteristics

Values

See Also

Store message names from CAN database

The Messages property stores the names of all messages defined in
the selected CAN database.

Usage CAN database
Read only Always
Data type String

The Messages property displays a cell array of strings. You cannot
edit this property.

canDatabase, messageInfo
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MessagesAvailable property
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Purpose

Description

Characteristics

Values

See Also

Display number of messages available to be received by CAN channel

The MessagesAvailable property displays the total number of
messages available to be received by a CAN channel.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no messages are available.
Functions
canChannel

Properties

MessagesReceived, MessagesTransmitted



MessagesReceived property

Purpose

Description

Characteristics

Values

See Also

Display number of messages received by CAN channel

The MessagesReceived property displays the total number of messages
received since the channel was last started.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no messages have been received. This number
increments based on the number of messages the channel receives.

Functions

canChannel, canHWInfo

Properties

MessagesAvailable, MessagesTransmitted
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MessagesTransmitted property
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Purpose

Description

Characteristics

Values

See Also

Display number of messages transmitted by CAN channel

The MessagesTransmitted property displays the total number of
messages transmitted since the channel was last started.

Usage CAN channel
Read only Always
Data type Double

The default is 0 when no messages have been sent. This number
increments based on the number of messages the channel transmits.

Functions
canChannel

Properties

MessagesAvailable, MessagesReceived



Name (Database) property

Purpose

Description

Characteristics

Values

See Also

CAN database name

The Name (Database) property displays the name of the database.

Usage CAN database
Read only Always
Data type String

Name is a string value. This value is acquired from the name of the
database file. You cannot edit this property.

Functions

canDatabase

Properties
Extended, ID
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Name (Message) property

Purpose CAN message name
Description The Name (Message) property displays the name of the message.
Characteristics ygage CAN message
Read only Always
Data type String
Values Name is a string value. This value is acquired from the name of the

message you defined in the database. You cannot edit this property if
you are defining raw messages.

See Also Functions

canMessage

Properties
Extended, ID
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NumOfSamples property

Purpose

Description

Characteristics

Values

See Also

Display number of samples available to channel

The NumOfSamples property displays the total number of samples
available to this channel. If you do not specify a value, the BusSpeed
property determines the default value.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Usage CAN channel
Read only Always
Data type Double

The value is a positive integer based on the driver settings for the
channel.

Functions

canChannel, configBusSpeed

Properties
BusSpeed, SJW, TSEG1, TSEG2

8-25



Path property

Purpose Display CAN database directory path
Description The Path property displays the path to the CAN database.
Characteristics ygage CAN database
Read only Always
Data type String
Values The path name is a string value, pointing to the CAN database in your
directory structure.
See Also Functions
canDatabase
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ReceiveErrorCount property

Purpose

Description

Characteristics

Values

See Also

Display number of received errors detected by channel

The ReceiveErrorCount property displays the total number of errors
detected by this channel during receive operations.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no error messages have been received.

Functions

canChannel, receive

Properties

TransmitErrorCount
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Remote property
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Purpose

Description

Characteristics

Values

Examples

See Also

Specify CAN message remote frame

Use the Remote property to specify the CAN message as a remote frame.

Usage CAN message
Read only Never
Data type Boolean

e [false} — The message is not a remote frame.

® true — The message is a remote frame.

To change the default value of Remote and make the message a remote
frame, type:

message.Remote = true

Functions

canMessage



Running property

Purpose

Description

Characteristics

Values

See Also

Determine status of CAN channel

The Running property displays information about the state of the CAN
channel.

Usage CAN channel
Read only Always
Data type Boolean

e [false} — The channel is offline.

e true — The channel is online.

Use the start function to set your channel online.

Functions

canChannel, start
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SilentMode property

Purpose

Description

8-30

Characteristics

Values

Examples

See Also

Specify if channel is active or silent

Specify whether the channel operates silently. By default SilentMode
is false. In this mode, the channel both transmits and receives
messages normally and performs other tasks on the network such as
acknowledging messages and creating error frames.

To observe all message activity on the network and perform analysis
without affecting the network state or behavior, change SilentMode to
true. In this mode, you can only receive messages and not transmit any.

Usage CAN channel
Read only Never
Data type Boolean

e [false} — The channel is in normal or active mode.

e true — The channel is in silent mode.
To configure the channel to silent mode, type:
canch.SilentMode = true

To configure the channel to normal mode, type:

canch.SilentMode = false

You can also use the set function to set the values of this property.

Functions

canChannel, set



Signals property

Purpose

Description

Characteristics

Examples

See Also

Display physical signals defined in CAN message

The Signals property allows you to view and edit signal values defined
for a CAN message. This property displays an empty structure if the

message has no defined signals or a CAN database is not attached to the
message. The input values for this property depends on the signal type.

Usage CAN message
Read only Sometimes
Data type Structure

Display signals defined in the CAN message, message:

message.Signals
ans =

VehicleSpeed: 0
EngineRPM: 250

Change the value of a signal:

message.Signals.EngineRPM = 300

Functions

canMessage, canDatabase
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SJW property

Purpose Display synchronization jump width (SJW) of bit time segment

Description In order to adjust the on-chip bus clock, the CAN controller may shorten
or prolong the length of a bit by an integral number of time segments.
The maximum value of these bit time adjustments are termed the
synchronization jump width or SJW.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Characteristics ygage CAN channel

Read only Always

Data type Numeric
Values The value of the SJW is determined by the specified bus speed.
See Also Functions

canChannel, configBusSpeed

Properties
BusSpeed, NumOfSamples, TSEG1, TSEG2
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Timestamp property

Purpose

Description

Characteristics

Values

Examples

See Also

Display message received timestamp

The Timestamp property displays the time at which the message
was received on a CAN channel. This time is based on the receiving
channel’s start time.

Usage CAN message
Read only Never
Data type Double

Timestamp displays a numeric value indicating the time the message
was received, based on the start time of the CAN channel

To set the time stamp of a message to 12, type:

message.Timestamp = 12

Functions

canChannel, canMessage, receive, replay
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TransceiverName property
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Purpose

Description

Characteristics

Values

See Also

Display name of CAN transceiver

The CAN transceiver translates the digital bit stream going to and
coming from the CAN bus into the real electrical signals present on
the bus.

Usage CAN channel
Read only Always
Data type String

Values are automatically defined when you configure the channel with
the canChannel function.

Functions
canChannel

Properties

TransceiverState



TransceiverState property

Purpose Display state or mode of CAN transceiver

Description If your CAN transceiver allows you to control its mode, you can use the
TransceiverState property to set the mode.

Characteristics ygage CAN channel
Read only Never
Data type Numeric
Values The values are defined by the transceiver manufacturer. Refer to your

CAN transceiver documentation for the appropriate transceiver modes.
Possible modes representing the numeric value specified are:

® high speed
® high voltage
® sleep

® wake up

See Also Functions

canChannel

Properties

TransceiverName
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TransmitErrorCount property
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Purpose

Description

Characteristics

Values

See Also

Display number of transmitted errors by channel

The TransmitErrorCount property displays the total number of errors
detected by this channel during transmit operations.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no error messages have been transmitted.

Functions

canChannel, transmit

Properties

ReceiveErrorCount



TSEG1 property

Purpose

Description

Characteristics

Values

See Also

Display amount that channel can lengthen sample time

The TSEG1 property displays the amount in bit time segments that the
channel can lengthen the sample time to compensate for delay times
in the network.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Usage CAN channel
Read only Always
Data type Double

The value is inherited when you configure the bus speed of your CAN
channel.

Functions

canChannel, configBusSpeed

Properties
BusSpeed, NumOfSamples, SJUW, TSEG2
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TSEG2 property

Purpose Display amount that channel can shorten sample time

Description The TSEG2 property displays the amount of bit time segments the
channel can shorten the sample to resynchronize.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Characteristics ygage CAN channel
Read only Always
Data type Double
Values The value is inherited when you configure the bus speed of your CAN
channel.
See Also Functions

canChannel, configBusSpeed

Properties
BusSpeed, NumOfSamples, SJW, TSEG1
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UserData property
|

Pu rpose Enter custom data

Description Use the UserData property to enter custom data to be stored in your
CAN channel, message, or database object. When you save an object
with UserData specified, you automatically save the custom data. When
you load an object with UserData specified, you automatically load the
custom data.

Note To avoid unexpected results when you save and load an object
with UserData, specify your custom data in simple data types and

constructs.
Characteristics Usage CAN channel, CAN Message, CAN Database
Read only Never
Data type User defined
See Also Functions

canChannel, canMessage, canDatabase
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Block Reference




CAN Configuration

Purpose
Library

Description

Configure parameters for specified CAN device

Vehicle Network Toolbox: CAN Communication

Wector CANcaseXL 1
Channel 1
Bus speed: 500000

CAN Configuration

The CAN Configuration block configures parameters for a CAN device
that you can use to transmit and receive messages.

Specify the configuration of your CAN device before you configure other
CAN blocks.

Use one CAN Configuration block to configure each device that sends
and receives messages in your model. If you use a CAN Receive or a
CAN Transmit block to receive and send messages on a device, your
model checks to see if there is a corresponding CAN Configuration block
for the specified device. If the device is not configured, you will see a
prompt advising you to use a CAN Configuration block to configure

the specified device.

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

Other Supported Features

The CAN Configuration block supports the use of Simulink
Accelerator™ mode. Using this feature, you can speed up the execution
of Simulink models.

For more information on this feature, see the Simulink documentation.

The CAN Configuration block supports the use of code generation when
you use it with the CAN Receive and CAN Transmit blocks.



CAN Configuration
|

Dialog Use the Block Parameters dialog box to select your CAN device
Box configuration.

x

—CAM Configuration

Configure the properties for the spedfied CAN device,

—Parameters
Device: Ii.-'ecb:-r CAMcaseXL 1 {Channel 1) LI
Busspeed: 500000

[~ Enable bit parameters manually:

Synchronization jump width: I 1

Time segment 1: |—1
Time segment 2: I 3
Mumber of samples: I 1

vierify bit parameter settings validity ... |

Acknowledge mode: INormaI ;I

CK. I Cancel | Help | Apply |

Device
Select the CAN device and a channel on the device that you want
to use from the list. Use this device to transmit and/or receive
messages. The device driver determines the default bus speed.

Bus speed
Set the bus speed property for the selected device. The default
bus speed is the default assigned by the selected device.

Enable bit parameters manually

Note This option is disabled if you are using an NI CAN channel.

9-3



CAN Configuration
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Select this check box to specify bit parameter settings manually.
The bit parameter settings include:

Synchronization jump width, Time segment 1, Time
segment 2, and Number of samples. If you do not select this
option, the device automatically assigns the bit parameters
depending on the bus speed setting.

Tip Use the default bit parameter settings unless you have
specific timing requirements for your CAN connection.

Synchronization jump width

Specify the maximum value of the bit time adjustments. The
specified value must be a positive integer. If you do not specify
a value, the selected bus speed setting determine the default
value. To change this value, select the Enable bit parameters
manually check box first. Refer to the SUW property for more
information.

Time segment 1

Specify the amount of bit time segments that the channel can
lengthen the sample time. The specified value must be a positive
integer. If you do not specify a value, the selected bus speed
setting determines the default value. To change this value, select
the Enable bit parameters manually check box first. Refer to
the TSEG1 property for more information.

Time segment 2

Specify the amount of bit time segments that the channel can
shorten the sample time to resynchronize. The specified value
must be a positive integer. If you do not specify a value, the
selected bus speed setting determines the default value. To
change this value, select the Enable bit parameters manually
check box first. Refer to the TSEG2 property for more information.



CAN Configuration

Number of samples
Specify the total number of samples available to this channel. The
specified value must be a positive integer. If you do not specify
a value, the selected bus speed setting determines the default
value. To change this value, select the Enable bit parameters
manually check box first. Refer to the NumOfSamples property
for more information.

Verify bit parameter settings validity
If you have set the bit parameter settings manually, click this
button to see if your settings are valid. The block then runs a
check to see if the combination of your bus speed setting and the
bit parameter value forms a valid value for the CAN device. If the
new bit parameter values do not form a valid combination, the
verification fails and displays an error message.

Acknowledge mode
Specify whether the channel is in Normal or Silent mode. By
default Acknowledge mode is Normal. In this mode, the
channel both receives and transmits messages normally and
performs other tasks on the network such as acknowledging
messages and creating error frames. To observe all message
activity on the network and perform analysis, without affecting
the network state or behavior, select Silent. In Silent mode, you
can only receive messages and not transmit.

Notes

® You cannot specify the mode if you are using NI virtual
channels.

¢ Use Silent mode only if you want to observe and analyze your
network activity.

See Also CAN Receive, CAN Transmit



CAN Log

Purpose Log received CAN messages
Librclry Vehicle Network Toolbox: CAN Communication
Description

File: untitled.mat
ariable: ans
Mo device selected

CAM Log

The CAN Log block logs CAN messages from the CAN network or
messages sent to the blocks input port to a .mat file. You can load the
saved messages into MATLAB for further analysis or into another
Simulink model.

Note If your model uses a National Instruments device, you cannot
connect CAN Receive block and CAN Log to the same channel on the
device.

You cannot connect a channel on a National Instruments device to
more than one block. Configure your CAN Log block to log from the
Simulink input port. Refer to the Basic CAN Message Replay and
Logging demo in the Vehicle Network Toolbox Simulink Demos for
more information.

The Log block appends the specified filename with the current date and
time, creating unique log files for repeated logging.

If you want to use messages logged using Simulink blocks in the
MATLAB Command window, use canMessage to convert messages to
the correct format. Refer to the Basic CAN Message Replay and
Logging demo in the Vehicle Network Toolbox Simulink Demos for
information.



CAN Log

Code
Generation

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

Other Supported Features

The CAN Log block supports the use of Simulink Accelerator mode.
Using this feature, you can speed up the execution of Simulink models.

For more information on this feature, see the Simulink documentation.

The CAN Log block supports the use of code generation along with the
packNGo function to group required source code and dependent shared
libraries. For more information, see Code Generation.

Vehicle Network Toolbox Simulink blocks allow you to generate
code, enabling models containing these blocks to run successfully in
Accelerator, Rapid Accelerator, External, and Deployed modes.

Code Generation with the Simulink Coder™

You can use Vehicle Network Toolbox, Simulink Coder, and Embedded
Coder™products together to generate code (on the host end) that you
can use to implement your model for a practical application. For more
information on code generation, see Building Executables.

Shared Library Dependencies

The block generates code with limited portability. The block uses
precompiled shared libraries, such as DLLs, to support I/O for specific
types of devices. With this block, you can use the packNGo function
supported by the Simulink Coder, to set up and manage the build
information for your models. The packNGo function allows you to
package model code and dependent shared libraries into a zip file for
deployment. You do not need MATLAB installed on the target system,
but the target system needs to be supported by MATLAB.

To set up packNGo:

set_param(gcs, 'PostCodeGenCommand', 'packNGo(buildInfo)');



CAN Log

In this example, gcs is the current model that you wish to build.
Building the model creates a zip file with the same name as model
name. You can move this zip file to another machine and the source
code 1n the zip file can be built to create an executable which can be run
independent of MATLAB and Simulink. The generated code compiles
with both C and C++ compilers. For more information on packNGo,

see packNGo.

Dialog Use the Block Parameters dialog box to configure your message logging.
Box

Tip If you are logging from the network, you need to configure your
CAN channel with a CAN Configuration block.

x

— CAN Log

Log CAN Messages to a MAT file.

— Parameters

File name: Iuntitled.mat Browse...

Variable name: |ans

Maximum number of messages to log: | 10000

Log messages from: |CAN Bus j

Device: |Se|ect a device j

Sample time: |III.EIl

oK Cancel Help | Apply




CAN Log

File name
Type the name and path of the file to log CAN messages to, or
click Browse to browse to a file location.

The model appends the log file name with the current date and
time in the YYYY-MMM-DD_hhmmss format. You can also open the
block mask and specify a unique name to differentiate between
your files for repeated logging.

Variable Name
Type the variable saved in the MAT-file that holds the CAN
message information.

Maximum number of messages to log
Specify the maximum number of messages this block can log from
the selected device or port. The specified value must be a positive
integer. If you do not specify a value the block uses the default
value of 10,000 messages. The log file saves the most recent
messages up to the specified maximum number.

Log messages from
Select the source of the messages logged by the block. Possible
values are CAN Bus or Input port. To log messages from the
network, you must specify a device.

Device
Select the device on the CAN network that you want to log
messages from. This filed 1s unavailable if you select Input port
for Log messages from option.

Sample time

Specify the sampling time of the block during simulation, which is
the simulation time as described by the Simulink documentation.
This value defines the frequency at which the CAN Log block runs
during simulation. If the block is inside a triggered subsystem or
to inherit sample time, you can specify —1 as your sample time.
You can also specify a MATLAB variable for sample time. The
default value is 0.01 (in seconds).
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See Also CAN Replay
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CAN Pack

Purpose

Library

Description

Pack individual signals into CAN message

CAN Communication

Embedded Coder/ Embedded Targets/ Host Communication

Data

IMessages: CAN Msg -
Standard |D: 250

CAN Msg

CAN Padk
[With raw data input)

Signall
Signal2 pzcage: CAN Msg CAN M
Signaly Standsrd ID:250 8

Signal4

CAN Padk
[With manuslly specified data input)

Dri\-‘ErE‘-‘:}Eer:k

ile: demoVNT_CANdbFiles.dbc
Message: DoorControlMsg  CAN Msg

Standard 1D0: 250

FPassengerDoorLodk

(With CANdb specified data input)

CAN Padk

The CAN Pack block loads signal data into a message at specified
intervals during the simulation.

Note To use this block, you also need a license for Simulink software.

CAN Pack block has one input port by default. The number of input
ports is dynamic and depends on the number of signals you specify

for the block. For example, if your block has four signals, it has four
input ports.

Signali
Signalz
Signal3

Signald

hessage: CAN hsg
Standard ID: 250 CAM Msgp

This block has one output port, CAN Msg. The CAN Pack block takes

CAN Fack

the specified input parameters and packs the signals into a message.
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CAN Pack
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Other Supported Features

The CAN Pack block supports:

® The use of Simulink Accelerator mode. Using this feature, you can
speed up the execution of Simulink models.

® The use of model referencing. Using this feature, your model can
include other Simulink models as modular components.

® Code generation using Simulink Coder to deploy models to targets.

Note Code generation is not supported if your signal information
consists of signed or unsigned integers greater than 32-bits long.

For more information on these features, see the Simulink
documentation.



CAN Pack

Use the Function Block Parameters dialog box to select your CAN Pack

block parameters.

x
—CAN Pack
Pack data into a CAN Message.
—Parameters
Data is input as: |raw data LI
CANdb file: I Browse... |
Message list: I(none} LI
—Message
MName: ICAN Msg
Identifier type: IStandard {11-bit identifier) ;I
Identifier: I 250
Length (bytes): |B
[ Remote frame
QK I Cancel Help Apply

Parameters

Data is input as
Select your data signal:

¢ raw data: Input data as a uint8 vector array. If you select this
option, you only specify the message fields. All other signal
parameter fields are unavailable. This option opens only one

input port on your block.

¢ manually specified signals: Allows you to specify data signal
definitions. If you select this option, use the Signals table to
create your signals. The number of input ports on your block
depends on the number of signals you specify.
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x
—CAN Pack
Pack data into a CAN Message,
—Parameters
Data is input as: |manual|y specified signals LI
CANdb file: I Browse... |
Message list: I(none) LI
—Message
Mame: IC.-'-\N Msg
Identifier type: IStandard {11-bit identifier) LI
Identifier: I 250
Length (bytes): |8
™ Remote frame
Signals: Add signal Delete signal
Name Ei‘:"t E:i';f)ﬁ‘ E:’;’:r ?::e’ nﬂ:f"e" T;'L:"ef"e" Factor |Offset |Min |Max
Signall 1] B|LE = |[signed LIStandard hd o 1 0| -Inf| Inf
Signal2 8 slte =llsigned  =|fstandard |+ 0 1 0| Inf| Inf
Signal3 16 8jle =|jsigned  =|lstandard =] 0 1 0| Anf| Inf
Signald| 24 8jle =|jsigned  =|lstandard  +| 0 1 0| Anf| Inf
oK I Cancel | Help | Apply |

¢ CANdb specified signals: Allows you to specify a CAN

database file that contains message and signal definitions.

If

you select this option, select a CANdb file. The number of input
ports on your block depends on the number of signals specified

in the CANdDb file for the selected message.




CAN Pack

[ Function Block Parameters: CAN Pack x|

—CAN Pack

Pack data into a CAN Message.,

—Parameters
Data is input as: |CANdb specified signals LI
CANdb file: ICANdeiIes.dbc Browse... |
Message list: IDDDrConh’oIMsg LI
—Message
Mame: I DoorControlMsg
Identifier type: IStandard {11-bitidentifier) LI
Identifier: |4DD

Length {bytes): |8

™ Remote frame

Signals: Add signal Delete signal
Start [Length |Byte |Data Multiplex Multiplex X
Name bit i) e = s value Factor |Offset |[Min |Max
DriverD 1 1LE _x Jjunsigned LI Standard x| 1] 1 1] 1] 1
Passen; 1] 1LE _x Jjunsigned jlstandard hd 1] 1 1] 1] 1

QK I Cancel | Help | Apply:

CANdb file
This option is available if you specify that your data is input via
a CANdb file in the Data is input as list. Click Browse to find
the appropriate CANdb file on your system. The message list
specified in the CANdD file populates the Message section of the
dialog box. The CANdb file also populates the Signals table for
the selected message.
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Note File names that contain non-alphanumeric characters
such as equal signs, ampersands, and so forth are not valid
CAN database file names. You can use periods in your database
name. Rename any CAN database files with non-alphanumeric
characters before you use them.

Message list
This option 1s available if you specify that your data is input via a
CAN(db file in the Data is input as field and you select a CANdb
file in the CANdDb file field. Select the message to display signal
details in the Signals table.

Message

Name
Specify a name for your CAN message. The default is CAN
Msg. This option is available if you choose to input raw data or
manually specify signals. This option in unavailable if you choose
to use signals from a CANdD file.

Identifier type
Specify whether your CAN message identifier is a Standard or an
Extended type. The default is Standard. A standard identifier
is an 11-bit identifier and an extended identifier is a 29-bit
identifier. This option is available if you choose to input raw data
or manually specify signals. For CANdb specified signals, the
Identifier type inherits the type from the database.

Identifier
Specify your CAN message ID. This number must be a positive
integer from O through 2047 for a standard identifier and from
0 through 536870911 for an extended identifier. You can also
specify hexadecimal values using the hex2dec function. This
option is available if you choose to input raw data or manually
specify signals.
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Length (bytes)
Specify the length of your CAN message from 0 to 8 bytes. If you
are using CANdb specified signals for your data input, the
CAN(db file defines the length of your message. If not, this field
defaults to 8. This option is available if you choose to input raw
data or manually specify signals.

Remote frame
Specify the CAN message as a remote frame.

Signals Table

This table appears if you choose to specify signals manually or define
signals using a CANdDb file.

If you are using a CANdDb file, the data in the file populates this table
automatically and you cannot edit any fields. To edit signal information,
switch to manually specified signals.

If you have selected to specify signals manually, create your signals
manually in this table. Each signal you create has the following values:

Name
Specify a descriptive name for your signal. The Simulink block
in your model displays this name. The default is Signal [row
number].

Start bit
Specify the start bit of the data. The start bit is the least
significant bit counted from the start of the message data. The
start bit must be an integer from 0 through 63.

Length (bits)
Specify the number of bits the signal occupies in the message. The
length must be an integer from 1 through 64.

Byte order
Select either of the following options:

e LE: Where the byte order is in little-endian format (Intel®).
In this format you count bits from the start, which is the
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least significant bit, to the most significant bit, which has the
highest bit index. For example, if you pack one byte of data in
little-endian format, with the start bit at 20, the data bit table
resembles this figure.

Bit Number
—
g Bit 7 Bitb Bit5 Bit 4 Bit3 Bit2 Bitl Bit 0
=
3
=
o 7 3 5 4 3 2 1 0
>
0O Byte 0
s 15 14 13 12 11 10 3 8
o
(]
Byte 1
16
Byte 2
31 a0 29 28
Data begins at the least significant
Byte 3 bit and starts at 20
a9 as a7 a6 s 34 a3 3z
Data is writen up to the most significant
Byte 4 bit and ends at 27
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 &1 &0 59 58 57 56
Byte 7

Little-Endian Byte Order Counted from the Least Significant Bit
to the Highest Address

e BE: Where byte order is in big-endian format (Motorola®). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit. For example, if you
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pack one byte of data in big-endian format, with the start bit at
20, the data bit table resembles this figure.

Bit Number

Bit7 Bit6 Bit 5 Bitd Bit 2 Bitl Bit0

Bit3

Data Byte Number

13 17
Data iswriten up to the most
significant bit and ends at |11
31 a0 29 27 26 5 24
Data begins at the least significant
Byte 3 it and starts at 20
a9 L a7 a6 as 34 a3 az
Byte 4
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 61 &0 59 58 57 56
Byte 7

Big-Endian Byte Order Counted from the Least Significant Bit
to the Lowest Address

Data type
Specify how the signal interprets the data in the allocated bits.

Choose from:
e signed (default)

® unsigned
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® single
® double

Multiplex type
Specify how the block packs the signals into the CAN message
at each timestep:

e Standard: The signal is always packed at each timestep.

® Multiplexor: The Multiplexor signal, or the mode signal is
always packed. You can specify only one Multiplexor signal
per message.

e Multiplexed: The signal is packed if the value of the
Multiplexor signal (mode signal) at run time matches the
configured Multiplex value of this signal.

For example, a message has four signals with the following types

and values.
Signal Name Multiplex Type Multiplex Value
Signal-A Standard N/A
Signal-B Multiplexed 1
Signal-C Multiplexed 0
Signal-D Multiplexor N/A

In this example:

¢ The block packs Signal-A (Standard signal) and Signal-D
(Multiplexor signal) in every timestep.

e [f the value of Signal-D is 1 at a particular timestep, then the
block packs Signal-B along with Signal-A and Signal-D in that
timestep.

e [f the value of Signal-D is 0 at a particular timestep, then the
block packs Signal-C along with Signal-A and Signal-D in that
timestep.
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e If the value of Signal-D is not 1 or 0, the block does not pack
either of the Multiplexed signals in that timestep.

Multiplex value
This option 1s available only if you have selected the Multiplex
type to be Multiplexed. The value you provide here must match
the Multiplexor signal value at run time for the block to pack
the Multiplexed signal. The Multiplex value must be a positive
integer or zero.

Factor
Specify the Factor value to apply to convert the physical value
(signal value) to the raw value packed in the message. See
“Conversion Formula” on page 9-21 to understand how physical
values are converted to raw values packed into a message.

Offset
Specify the Offset value to apply to convert the physical value
(signal value) to the raw value packed in the message. See
“Conversion Formula” on page 9-21 to understand how physical
values are converted to raw values packed into a message.

Min
Specify the minimum physical value of the signal. The default
value 1s -inf (negative infinity). You can specify any number
for the minimum value. See “Conversion Formula” on page 9-21
to understand how physical values are converted to raw values
packed into a message.

Max
Specify the maximum physical value of the signal. The default
value is inf. You can specify any number for the maximum
value. See “Conversion Formula” on page 9-21 to understand
how physical values are converted to raw values packed into a
message.

Conversion Formula

The conversion formula is

raw_value = (physical_value - Offset) / Factor
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where physical value is the value of the signal after it is saturated
using the specified Min and Max values. raw_value is the packed
signal value.

See Also CAN Unpack
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Purpose Receive CAN messages from specified CAN device
Librclry Vehicle Network Toolbox: CAN Communication

Description

Vector CANcaseXL 1 1
Channsl 1 )

Std. IDs: all .
Ext. IDs: all CAN Msg £

CAM Receive

The CAN Receive block receives messages from the CAN network and
delivers them to the Simulink model. It outputs one message or all
messages at each timestep, depending on the block parameters.

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

The CAN Receive block has two output ports:

¢ The f() output port is a trigger to a Function-Call subsystem. If
the block receives a new message, it triggers a Function-Call from
this port. You can then connect to a Function-Call Subsystem to
unpack and process a message.

® The CAN Msg output port contains a CAN message received at that

particular timestep.

The CAN Receive block stores CAN messages in a first-in, first-out
(FIFO) buffer. The FIFO buffer delivers the messages to your model in
the queued order at every timestep.
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Note You cannot have more than one Receive block connected to the
same NI device channel.

Other Supported Feature

The CAN Receive block supports the use of Simulink Accelerator mode.
Using this feature, you can speed up the execution of Simulink models.

For more information on this feature, see the Simulink documentation.

The CAN Receive block supports the use of code generation along with
the packNGo function to group required source code and dependent
shared libraries. For more information, see Code Generation.

Code Vehicle Network Toolbox Simulink blocks allow you to generate
Generation code, enabling models containing these blocks to run successfully in
Accelerator, Rapid Accelerator, External, and Deployed modes.

Code Generation with the Simulink Coder

You can use Vehicle Network Toolbox, Simulink Coder, and Embedded
Coderproducts together to generate code (on the host end) that you
can use to implement your model for a practical application. For more
information on code generation, see Building Executables.

Shared Library Dependencies

The block generates code with limited portability. The block uses
precompiled shared libraries, such as DLLs, to support I/O for specific
types of devices. With this block, you can use the packNGo function
supported by the Simulink Coder, to set up and manage the build
information for your models. The packNGo function allows you to
package model code and dependent shared libraries into a zip file for
deployment. You do not need MATLAB installed on the target system,
but the target system needs to be supported by MATLAB.

To set up packNGo:

set_param(gcs, 'PostCodeGenCommand', 'packNGo(buildInfo)');
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Dialog
Box

In this example, gcs is the current model that you wish to build.
Building the model creates a zip file with the same name as model
name. You can move this zip file to another machine and the source
code 1n the zip file can be built to create an executable which can be run
independent of MATLAB and Simulink. The generated code compiles
with both C and C++ compilers. For more information on packNGo,

see packNGo.

Use the Source Block Parameters dialog box to select your CAN Receive
block parameters.

Tip Configure your CAN Configuration block before you configure the
CAN Receive block parameters.

=) source Block Parameters: CAN Receive x|

— CAN Receive

Receive CAN Messages using the specified CAN device.

— Parameters

Device: |Vector Virtual 1 (Channel 2) j

Standard IDs Filter:

IAIIow all j ID

Extended IDs Filter:

|AIIOw all j ID

Sample time: ID.Dl

Number of messages received at each timestep: Iall 'l
0K I Cancel | Help | Apply |

Device
Select the CAN device and a channel on the device you want
to receive CAN messages from. This field lists all the devices
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installed on the system. It displays the vendor name, the device
name, and the channel ID. The default is the first available device
on your system.

Standard IDs Filter
Select the filter on this block for standard IDs. Valid choices are:

e Allow all: allows all standard IDs to pass the filter. This is
the default filter state of the CAN Receive block

e Allow only: Allows only ID or range of IDs specified in the text
field. You can specify a single ID or an array of IDs. You can
also specify disjointed IDs or arrays separated by a comma. For
example, to accept IDs from 400 through 500 and 600 through
650, enter [ [400:500] [600:650]]. Standard IDs must be a
positive integer from O through 2047. You can also specify a
hexadecimal value using the hex2dec function.

e Block all: Blocks all standard IDs from passing the filter.

Extended IDs Filter
Select the filter on this block for extended IDs. Valid choices are:

e Allow all: allows all extended IDs to pass the filter. This is
the default filter state of the CAN Receive block

e Allow only: Allows only ID or range of IDs specified in the
text field. You can specify a single ID or an array of IDs. You
can also specify disjointed IDs or arrays separated by a comma.
For example, to accept IDs from 3000 through 3500 and 3600
through 3620, enter [ [3000:3500] [3600:3620]]. Extended
IDs must be a positive integer from 0 through 536870911.
You can also specify a hexadecimal value using the hex2dec
function.

e Block all: Blocks all extended IDs from passing the filter.

Sample time
Specify the sampling time of the block during simulation, which is
the simulation time as described by the Simulink documentation.
This value defines the frequency at which the CAN Receive
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block runs during simulation. If the block is inside a triggered
subsystem or to inherit sample time, you can specify —1 as your
sample time. You can also specify a MATLAB variable for sample
time. The default value is 0.01 (in seconds).

Number of messages received at each timestep
Select how many messages the block receives at each specified
timestep. The choices are 1 and all. By default, the block receives
one message at each timestep. Then, the FIFO buffer delivers
one new message to the Simulink model. If the block does not
receive any message before the next timestep it outputs the last
received message.

If you select all, the CAN Receive block delivers all available
messages in the FIFO buffer to the model during a specific
timestep. The block generates one function call for every message
delivered to the model for that particular timestep. The output
port always contains one CAN message at a time.

See Also CAN Configuration, CAN Unpack
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Purpose
Library

Description

Replay logged CAN messages

Vehicle Network Toolbox: CAN Communication

File: untitled. mat
ariable: ans
Mo device selected

CAN Replay

The CAN Replay block replays logged messages from a .mat file to a
CAN network or to Simulink. You need a CAN Configuration block
to replay to the network.

To replay messages logged in the MATLAB Command window in
your Simulink model, convert them into a compatible format using
vntslgate and save it to a separate file. Refer to the Basic CAN
Message Replay and Logging demo in the Vehicle Network Toolbox
Simulink Demos for information.

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

Replay Timing

When you replay logged messages, Simulink uses the original
timestamps on the messages. When you replay to a network, the
timestamps correlate to real time, and when you replay to the Simulink
input port it correlates to simulation time. If the timestamps in the
messages are all 0, all messages are replayed as soon as the simulation
starts, because simulation time and real time will be ahead of the
timestamps in the replayed messages.



CAN Replay

Code
Generation

Other Supported Features

The CAN Replay block supports the use of Simulink Accelerator mode.
Using this feature, you can speed up the execution of Simulink models.

For more information on this feature, see the Simulink documentation.

The CAN Log block supports the use of code generation along with the
packNGo function to group required source code and dependent shared
libraries. For more information, see Code Generation.

Vehicle Network Toolbox Simulink blocks allow you to generate
code, enabling models containing these blocks to run successfully in
Accelerator, Rapid Accelerator, External, and Deployed modes.

Code Generation with the Simulink Coder

You can use Vehicle Network Toolbox, Simulink Coder, and Embedded
Coderproducts together to generate code (on the host end) that you
can use to implement your model for a practical application. For more
information on code generation, see Building Executables.

Shared Library Dependencies

The block generates code with limited portability. The block uses
precompiled shared libraries, such as DLLs, to support I/O for specific
types of devices. With this block, you can use the packNGo function
supported by the Simulink Coder, to set up and manage the build
information for your models. The packNGo function allows you to
package model code and dependent shared libraries into a zip file for
deployment. You do not need MATLAB installed on the target system,
but the target system needs to be supported by MATLAB.

To set up packNGo:

set_param(gcs, 'PostCodeGenCommand', 'packNGo(buildInfo)');

In this example, gcs is the current model that you wish to build.
Building the model creates a zip file with the same name as model
name. You can move this zip file to another machine and the source
code in the zip file can be built to create an executable which can be run
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independent of MATLAB and Simulink. The generated code compiles
with both C and C++ compilers. For more information on packNGo,
see packNGo.

Dialog Use the Source Block Parameters dialog box to select your message
Box replay options.

Tip Configure your CAN Configuration block before you configure the
CAN Receive block parameters.

=] Block Parameters: CAN Replay x|

— CAN Replay

Replay CAN Messages from a MAT file.

— Parameters

File name: |untit|ed.mat Browse...

Variable name:lans

Mumber of times to replay messages: |Inf

Replay messages to: ICAN Bus j

Device: |Select a device j

Sample time: |III.IIIl

oK Cancel Help | Apply |
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File name
Specify the name and path of the file that contains logged CAN
messages that you can replay. You can click Browse to browse to
a file location and select the file.

Variable name

Specify the variable saved in the MAT-file that holds the CAN
message information.

Number of times to replay messages
Specify the number of times you want the message replayed in
your model. You can specify any positive integer, including Inf.
Specifying Inf continuously replays messages until simulation
stops.

Replay messages to
Specify if the model is replaying messages to the CAN network or
an output port. Select a device to replay to the CAN network.

Device
Select the device on the CAN network to replay messages to. This
filed is unavailable if you select Input port for Replay message
to option.

Sample time
Specify the sampling time of the block during simulation, which is
the simulation time as described by the Simulink documentation.
This value defines the frequency at which the CAN Replay
block runs during simulation. If the block is inside a triggered
subsystem or to inherit sample time, you can specify —1 as your
sample time. You can also specify a MATLAB variable for sample
time. The default value is 0.01 (in seconds).

See Also CAN Log
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Purpose Transmit CAN message to selected CAN device
Librclry Vehicle Network Toolbox: CAN Communication
Description

CAN Msg Wector CANcaseXL 1

Channel 1

CAN Transmit

The CAN Transmit block transmits messages to the CAN network
using the specified CAN device. The CAN Transmit block can transmit
a single message or an array of messages during a given timestep. To
transmit an array of messages, use a mux (multiplex) block from the
Simulink block library.

Note You need a license for both Vehicle Network Toolbox and
Simulink s oftware to use this block.

The CAN Transmit block has one input port. This port accepts a CAN
message packed using the CAN Pack block. It has no output ports.

Other Supported Feature

The CAN Transmit block supports the use of Simulink Accelerator
mode. Using this feature, you can speed up the execution of Simulink
models.

For more information on this feature, see the Simulink documentation.

The CAN Transmit block supports the use of code generation along with
the packNGo function to group required source code and dependent
shared libraries. For more information, see Code Generation.
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Code
Generation

Vehicle Network Toolbox Simulink blocks allow you to generate
code, enabling models containing these blocks to run successfully in
Accelerator, Rapid Accelerator, External, and Deployed modes.

Code Generation with the Simulink Coder

You can use Vehicle Network Toolbox, Simulink Coder, and Embedded
Coderproducts together to generate code (on the host end) that you
can use to implement your model for a practical application. For more
information on code generation, see Building Executables.

Shared Library Dependencies

The block generates code with limited portability. The block uses
precompiled shared libraries, such as DLLs, to support I/O for specific
types of devices. With this block, you can use the packNGo function
supported by the Simulink Coder, to set up and manage the build
information for your models. The packNGo function allows you to
package model code and dependent shared libraries into a zip file for
deployment. You do not need MATLAB installed on the target system,
but the target system needs to be supported by MATLAB.

To set up packNGo:

set_param(gcs, 'PostCodeGenCommand', 'packNGo(buildInfo)');

In this example, gcs is the current model that you wish to build.
Building the model creates a zip file with the same name as model
name. You can move this zip file to another machine and the source
code in the zip file can be built to create an executable which can be run
independent of MATLAB and Simulink. The generated code compiles
with both C and C++ compilers. For more information on packNGo,

see packNGo.
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Dialog
Box

9-34

Use the Sink Block Parameters dialog box to select your CAN Transmit
block parameters.

Tip Configure your CAN Configuration block before you configure the
CAN Transmit block parameters.

= sink Block Parameters: CAN Transmit x|

—CAM Transmit

Transmit CAMN Messages using the specified CAM device.

—Parameters

[~ Tranzmit messages periodically

Message period {in seconds): I 1.000 ;I

0K Cancel Help | Apply |

Device

Select the CAN device and a channel on the device to use to
transmit CAN messages to the network. This list shows all the
devices installed on the system. It displays the vendor name, the
device name, and the channel ID. The default is the first available
device on your system.

Transmit messages periodically

Select this option to enable periodic transmit of the message on
the configured channel to transmit at the specified period.
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|

Message period (in seconds)
Specify a period in seconds. This value is used to transmit the
message in the specified period. By default this value is 1.000
seconds.

See Also CAN Configuration, CAN Pack
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Purpose Unpack individual signals from CAN messages

Librclry CAN Communication
Embedded Coder/ Embedded Targets/ Host Communication

o L
Description
Signall
. DriverDoorLod:
CAN r._1sgl-.-1essage: CAN Msg Data CANMsg Message: CAN sg Signal2 File: demcWNT_CAMdEFiles dbe
’ Standard ID: 250 . Standard ID: 250 . CAMN Msg Message: DoorControlMsg
Signalz Standard |D: 250
FPassengerDoorlodk
Signals
CAN Unpadk

CAN Unpads
{With manusally specified data cutput)

(With raw data cutput) CAN Unpadk

(With CANdE specified data cutput)

The CAN Unpack block unpacks a CAN message into signal data using

the specified output parameters at every timestep. Data is output as
individual signals.

Note To use this block, you also need a license for Simulink software.

The CAN Unpack block has one output port by default. The number
of output ports is dynamic and depends on the number of signals you
specify for the block to output. For example, if your block has four
signals, it has four output ports.

Signali

Meszage: CAN hisg Signalz

CAN M
" Standard I0:280  gignaiz

Signald

CAMN Unpack
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Other Supported Features

The CAN Unpack block supports:

® The use of Simulink Accelerator mode. Using this feature, you can
speed up the execution of Simulink models.

® The use of model referencing. Using this feature, your model can
include other Simulink models as modular components.

® Code generation using Simulink Coder to deploy models to targets.

Note Code generation is not supported if your signal information
consists of signed or unsigned integers greater than 32-bits long.

For more information on these features, see the Simulink
documentation.
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Dialog Use the Function Block Parameters dialog box to select your CAN
Box message unpacking parameters.
x
—CAM Unpack

Unpack data from a CAM Message.

—Parameters
Data to be output as: ©
CANdb file: I Browse... |
Message list: |(none} LI
—Message
Mame: |CAN Msg
Identifier type: |Standard (11-bit identifier) ;I
Identifier: I 250

Length (bytes): I 8

—Output ports

[~ output identifier [~ Cutput tmestamp [~ Cutput error

[ output remate [~ output length ™ output status
CK I Cancel Help Apply
Parameters

Data to be output as
Select your data signal:

* raw data: Output data as a uint8 vector array. If you select
this option, you only specify the message fields. All other signal
parameter fields are unavailable. This option opens only one
output port on your block.

e manually specified signals: Allows you to specify data
signals. If you select this option, use the Signals table to
create your signals message manually.
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x
—CAM Unpack-
Unpack data from a CAN Message.
—Parameters
Data to be output as:
CANdb file: I Browse... |
Message list: I(none} LI
Messag
MName: ICAN Msg
Identifier type: IStandard {11-bit identifier) j
Identifier: I 250
Length (bytes): |8
Signals: Add signal Delete signal |
Name Ei‘frt E’E}m E:’;:r E::: ’;ﬂ:de“ T;'L:’:"e" Factor |Offset |Min |Max
Signall 1] 8|LE = ||signed LlStandard hd 1] 1 0| -Inf| Inf
Signal2 8 sfie =lfsigned  =[fstandard =] 0 1 0| Inf| Inf
Signal3 16 8JlE =lfsianed  =lfstandard x| 0 1 0| Inf| Inf
Signal4| 24 8|l =llsigned  =|lstandard =] 0 1 0| Anf| Inf
—Output ports
[T Output identifier [~ Output timestamp [~ output error
[~ output remote ™ Output length ™ Output status
Ok I Cancel | Help | Apply

The number of output ports on your block depends on the

number of signals you specify. For example, if you specify four

signals, your block has four output ports.

CANdb specified signals: Allows you to specify a CAN
database file that contains data signals. If you select this
option, select a CANdD file.
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E! Function Block Parameters: CAN Unpack (With CANdb specified data output)

—CAM Unpack-

Unpack data from a CAN Message.

—Parameters

Data to be output as:

CANdb file: I CANdbFiles.dbc Browse... |

Message list: IDDDrConh’oIMsg LI
Messag
Mame: I DoorControlMsg
Identifier type: IStandard (11-bit identifier) j
Identifier: |4DD

Length (bytes): I 8

Signals: Add signal Delete signal |
Start [Length |Byte |Data Multiplex Multiplex .
Name bit (bits) order value Factor |Offset |Min |Max
DriverD 1 LLE = Jjunsigned LI Standard x| o] 1 1] 1] 1
Passeny 1] LLE = Jjunsigned LIIStandard hd o] 1 1] 1] 1
—Output ports

™ output identifier [~ Output timestamp [~ output error
™ Output remate ™ Output length ™ Output status

oK I Cancel | Help | Apply

The number of output ports on your block depends on the
number of signals specified in the CANdb file. For example, if
the selected message in the CANdb file has four signals, your
block has four output ports.

CANdb file
This option 1s available if you specify that your data is input via a
CAN(db file in the Data to be output as list. Click Browse to
find the appropriate CANdb file on your system. The messages
and signal definitions specified in the CANdDb file populate the
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Message section of the dialog box. The signals specified in the
CAN(db file populate Signals table.

Note File names that contain non-alphanumeric characters
such as equal signs, ampersands, and so forth are not valid
CAN database file names. You can use periods in your database
name. Rename any CAN database files with non-alphanumeric
characters before you use them.

Message list
This option 1s available if you specify that your data is to be
output as a CANdD file in the Data to be output as list and you
select a CANdb file in the CANdDb file field. You can select the
message that you want to view. The Signals table then displays
the details of the selected message.

Message

Name
Specify a name for your CAN message. The default is CAN Msg.
This option is available if you choose to output raw data or
manually specify signals.

Identifier type
Specify whether your CAN message identifier is a Standard or an
Extended type. The default is Standard. A standard identifier
is an 11-bit identifier and an extended identifier is a 29-bit
identifier. This option is available if you choose to output raw
data or manually specify signals. For CANdb-specified signals,
the Identifier type inherits the type from the database.

Identifier
Specify your CAN message ID. This number must be a integer
from O through 2047 for a standard identifier and from 0 through
536870911 for an extended identifier. If you specify 1, the block
unpacks all messages that match the length specified for the
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message. You can also specify hexadecimal values using the
hex2dec function. This option is available if you choose to output
raw data or manually specify signals.

Length (bytes)
Specify the length of your CAN message from 0 to 8 bytes. If you
are using CANdb specified signals for your output data, the
CAN(db file defines the length of your message. If not, this field
defaults to 8. This option is available if you choose to output raw
data or manually specify signals.

Signals Table

This table appears if you choose to specify signals manually or define
signals using a CANdDb file.

If you are using a CANdDb file, the data in the file populates this table
automatically and you cannot edit any fields. To edit signal information,
switch to manually specified signals.

If you have selected to specify signals manually, create your signals
manually in this table. Each signal you create has the following values:

Name
Specify a descriptive name for your signal. The Simulink block
in your model displays this name. The default is Signal [row
number].

Start bit
Specify the start bit of the data. The start bit is the least
significant bit counted from the start of the message. The start
bit must be an integer from 0 through 63.

Length (bits)
Specify the number of bits the signal occupies in the message. The
length must be an integer from 1 through 64.

Byte order
Select either of the following options:
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e | E: Where the byte order is in little-endian format (Intel). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit, which has the
highest bit index. For example, if you pack one byte of data in
little-endian format, with the start bit at 20, the data bit table
resembles this figure.

Bit Number
—
g Bit 7 Bitb Bit5 Bit 4 Bit3 Bit2 Bitl Bit 0
=
3
=
o 7 3 5 4 3 2 1 0
>
0O Byte 0
s 15 14 13 12 11 10 3 8
o
(]
Byte 1
19 138 17 16
Byte 2
31 a0 29 28
Data begins at the least significant
Byte 3 bit and starts at 20
a9 as a7 a6 s 34 a3 3z
Data is writen up to the most significant
Byte 4 bit and ends at 27
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 &1 &0 59 58 57 56
Byte 7

Little-Endian Byte Order Counted from the Least Significant Bit
to the Highest Address

® BE: Where the byte order is in big-endian format (Motorola). In
this format you count bits from the start, which is the least

9-43



CAN Unpack

significant bit, to the most significant bit. For example, if you
pack one byte of data in big-endian format, with the start bit at
20, the data bit table resembles this figure.

Bit Number
5 Bit7 Bité Bit 5 Bitd Bit3 Bit2 Bitl Bit0
o
=
3
= 7 3 5 4 3 2 1 0
2
& Byte0
© 15 14 13 12
5
Byte 1
19 13 17 16
Data _is writen up to the most
Byte 2 significant bit and ends at |11
31 a0 29 23 27 26 5 24
Data beg_ins at the least significant
Byte 3 kit and starts at 20
a9 L a7 a6 as 34 a3 az
Byte 4
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 61 &0 59 58 57 56
Byte 7

Big-Endian Byte Order Counted from the Least Significant Bit
to the Lowest Address

Data type
Specify how the signal interprets the data in the allocated bits.

Choose from:

® signed (default)
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® unsigned
® single
® double

Multiplex type

Specify how the block unpacks the signals from the CAN message

at each timestep:

e Standard: The signal is always unpacked at each timestep.

® Multiplexor: The Multiplexor signal, or the mode signal is
always unpacked. You can specify only one Multiplexor signal

per message.

e Multiplexed: The signal is unpacked if the value of the
Multiplexor signal (mode signal) at run time matches the
configured Multiplex value of this signal.

For example, a message has four signals with the following values.

Signal Name Multiplex Type Multiplex Value
Signal-A Standard N/A

Signal-B Multiplexed 1

Signal-C Multiplexed 0

Signal-D Multiplexor N/A

In this example:

® The block unpacks Signal-A (Standard signal) and Signal-D

(Multiplexor signal) in every timestep.

e [f the value of Signal-D is 1 at a particular timestep, then the
block unpacks Signal-B along with Signal-A and Signal-D in

that timestep.
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e If the value of Signal-D is 0 at a particular timestep, then the
block unpacks Signal-C along with Signal-A and Signal-D in
that timestep.

¢ If the value of Signal-D is not 1 or 0, the block does not unpack
either of the Multiplexed signals in that timestep.

Multiplex value
This option is available only if you have selected the Multiplex
type to be Multiplexed. The value you provide here must match
the Multiplexor signal value at run time for the block to unpack
the Multiplexed signal. The Multiplex value must be a positive
integer or zero.

Factor
Specify the Factor value applied to convert the unpacked raw
value to the physical value (signal value). See “Conversion
Formula” on page 9-47 to understand how unpacked raw values
are converted to physical values.

Offset
Specify the Offset value applied to convert the physical value
(signal value) to the unpacked raw value. See “Conversion
Formula” on page 9-47 to understand how unpacked raw values
are converted to physical values.

Min
Specify the minimum raw value of the signal. The default value
is -inf (negative infinity). You can specify any number for the
minimum value. See “Conversion Formula” on page 9-47 to
understand how unpacked raw values are converted to physical
values.

Max
Specify the maximum raw value of the signal. The default value
is inf. You can specify any number for the maximum value. See
“Conversion Formula” on page 9-47 to understand how unpacked
raw values are converted to physical values.
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Output Ports
Selecting an Output ports option adds an output port to your block.

Output identifier
Select this option to output a CAN message identifier. The data
type of this port is uint32.

Output remote
Select this option to output the message remote frame status.
This option adds a new output port to the block. The data type of
this port is uint8.

Output timestamp
Select this option to output the message time stamp. This option
adds a new output port to the block. The data type of this port
is double.

Output length
Select this option to output the length of the message in bytes.
This option adds a new output port to the block. The data type of
this port is uint8.

Output error
Select this option to output the message error status. This option
adds a new output port to the block. The data type of this port is
uint8.

Output status
Select this option to output the message received status. The
status 1s 1 if the block receives new message and 0 if it does not.
This option adds a new output port to the block. The data type of
this port is uint8.

If you do not select any Output ports option, the number of output
ports on your block depends on the number of signals you specify.

Conversion Formula

The conversion formula is
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physical_value = raw_value * Factor + Offset

where raw_value is the unpacked signal value. physical value is the
scaled signal value which is saturated using the specified Min and
Max values.

See Also CAN Pack
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